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SUMMARY

This guide is a troubleshooting reference used for maintaining and servicing the computer. It provides
comprehensive information on identifying computer features, components, and spare parts;
troubleshooting computer problems; and performing computer disassembly procedures.
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Safety warning notice

WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not
place the computer directly on your lap or obstruct the computer air vents. Use the computer only on
a hard, flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to
contact the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer
and the AC adapter comply with the user-accessible surface temperature limits defined by the
International Standard for Safety of Information Technology Equipment (IEC 60950).
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MSG revision history

Revision Publication date Description

A April 2010 Edited this guide to include HP G42 Notebook PC and Compaq CQ42
Notebook PC information only.

B October 2010 ● Added newly supported memory modules to spare parts listings in
the following locations: Computer major components on page 20,
Mass storage devices on page 29, Sequential part number listing
on page 31, Memory module on page 51.

● Added newly supported processors to spare parts listings in the
following locations: Computer major components on page 20,
Mass storage devices on page 29, Sequential part number listing
on page 31, Processor on page 83.

● Added newly supported system boards to spare parts listings in the
following locations: Computer major components on page 20,
Mass storage devices on page 29, Sequential part number listing
on page 31, System board on page 73.
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1 Product description

Category Description HP G42 Compaq
Presario

CQ42

Compaq
Presario

CQ42

Compaq
Presario

CQ42

UMA Discrete UMA Models
150 – 199

UMA Models
100 – 149

Product Name Compaq Presario CQ42 Notebook
PC

 √ √ √

 HP G42 Notebook PC √    

Processors Intel® Arrandale™     

 i7-620M, 2.66-GHz, SC turbo, 4-MB
L3 cache 

√ √ √  

 i5-540M, 2.53-GHz, SC turbo, 3-MB
L3 cache

√ √ √  

 i5-520M, 2.4-GHz, SC turbo, 3-MB
L3 cache

√ √ √  

 i5-430M 2.26-GHz (turbo to 2.53-
GHz) 3-MB L3 cache

√ √ √  

 i3-350M, 2.26-GHz 3-MB L3 cache √ √ √  

 i3-330M, 2.13-GHz 3-MB L3 cache √ √ √  

 Intel Pentium™     

 DC T4400, 2.2-GHz, 800-MHz FSB,
1-MB L2 cache

   √

 DC T4300, 2.1-GHz, 800-MHz FSB,
1-MB L2 cache

   √

 Intel Celeron™     

 DC T3100, 1.9-GHz, 800-MHz FSB,
1-MB L2 cache

   √

 DC T3000, 1.8-GHz 800-MHz FSB,
1-MB L2 cache

   √

 AMD® Phenom™ II Processor     

 DC N930 QC 2.0 GHz √ √ √  

 DC N830 Tri-core 2.1Ghz 1.5M L2
35W

√ √ √  
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Category Description HP G42 Compaq
Presario

CQ42

Compaq
Presario

CQ42

Compaq
Presario

CQ42

UMA Discrete UMA Models
150 – 199

UMA Models
100 – 149

 N620 DDR3-1333 Mhz √ √ √  

 DC QC P920 1.6Ghz 2M L2 25W √ √ √  

 DC P820 Tri-Core 1.8Ghz 1.5M L2
25W

√ √ √  

 DC P820 Tri-Core 1.8Ghz 1.5M L2
25W

√ √ √  

 AMD Turion™ II Processor     

 DC N530 DC 2.5GHz L2 35W √ √ √  

 P520 DDR3-1066 Mh √ √ √  

 AMD Athlon™ II Processor     

 DC N330 2.3GHz 1M L2 35W √ √ √  

 P320 DDR3-1066 Mhz √ √ √  

 AMD Sempron™ II Processor     

 N120 DDR3-1066 Mhz √ √ √  

Chipset Intel® HM55 Express √ √ √  

 Intel® GL40    √

 Southbridge: ICH9m    √

 AMD     

 ATI RS880M (Northbridge) √  √  

 ATI RS880MD (Northbridge)  √   

 Southbridge - SB820 √ √ √  

Graphics Intel UMA (integrated)/HD
Graphics with shared video memory
(memory size is dynamic change):

● Up to 251 MB on computers
with 1024 MB of system
memory

● Up to 358 MB on computers
with more than 2048 MB of
system memory

√  √  
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Category Description HP G42 Compaq
Presario

CQ42

Compaq
Presario

CQ42

Compaq
Presario

CQ42

UMA Discrete UMA Models
150 – 199

UMA Models
100 – 149

 Intel UMA (integrated)/GMA 4500M
- GL40 chipset with shared video
memory (memory size is dynamic
change):

● Up to 1759 MB for computers
with more than 4096 MB of
system memory (64 bit)

● Up to 1309 MB for computers
with more than 4096 MB of
system memory (32 bit)

● Up to 1309 MB for computers
with more than 3072 MB of
system memory

● Up to 797 MB for computers
with more than 2048 MB system
memory

● Up to 285 MB for computers
with more than 1024 MB of
system memory

   √

 ATi Discrete PCI Express x 16
Graphics

ATi Mobility Radeon Park-LP S3
package (ATI Mobility Radeon™
HD5430 with 512-MB of dedicated
video memory (64-MB×16 DDR3, 4
pcs, 800-MHz))

 √   

 Support for BD or HD-DVD
playback with HD decoder and
DX10 support

√ √ √ √

Panel 35.6-cm (14.0-in) HD LED
BrightView (1366 x 768 resolution)

√ √ √ √

 16:9 wide aspect ratio √ √ √ √

Memory 2 SODIMM slots √ √ √ √

 Customer-accessible and upgradable √ √ √ √

 Supports up to 8 GB of system
memory

√ √ √ √

 DDR3, 1066-MHz, dual-channel
memory (DDR3 1333 MHz can be
downgraded to DDR3 1066 MHz)

√ √ √  

 DDR3, 800-MHz, dual-channel
memory (DDR3 1333 MHz can be
downgraded to DDR3 800 MHz)

   √

 Supports the following configurations:     
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Category Description HP G42 Compaq
Presario

CQ42

Compaq
Presario

CQ42

Compaq
Presario

CQ42

UMA Discrete UMA Models
150 – 199

UMA Models
100 – 149

 ● 4096 MB (2048 MB × 2) √ √ √ √

 ● 3072 MB (1024 MB × 1 + 2048
MB × 1)

√ √ √ √

 ● 2048 MB (2048 MB × 1) √ √ √ √

 ● 2048 MB (1024 MB × 2) √ √ √ √

 ● 1024 MB (1024 MB × 1) √ √ √ √

Hard drives Supports 9.5-mm, 6.35-cm (2.5-in)
hard drives

√ √ √ √

 Serial ATA √ √ √ √

 Supports the following drives:     

 ● 640-GB 5400 RPM √ √ √  

 ● 500 GB, 7200 rpm √ √ √  

 ● 320 GB, 7200 rpm √ √ √ √

 ● 250 GB, 7200 rpm √ √ √ √

 ● 160 GB, 7200 rpm √ √ √  

Optical drives Fixed (removal of one screw
required)

√ √ √ √

 SATA √ √ √ √

 12.7-mm (0.50-in) tray load √ √ √ √

 Supports the following drives:     

 ● Blu-ray ROM with LightScribe
DVD±R/RW SuperMulti DL
Drive

√ √ √  

 ● Blu-ray ROM DVD±R/RW
SuperMulti DL Drive

√ √ √  

 ● DVD±R/RW SuperMulti DL
Drive with LightScribe

√ √ √ √

 ● DVD±R/RW SuperMulti DL
Drive

√ √ √ √

Diskette drive Supports external USB drive only √ √ √ √

Camera VGA camera √ √ √ √

 Fixed (no tilt) √ √ √ √

 640 × 480 by 24 frames per second √ √ √ √

Microphone One microphone, analog √ √ √ √

Audio HD audio √ √ √ √
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Category Description HP G42 Compaq
Presario

CQ42

Compaq
Presario

CQ42

Compaq
Presario

CQ42

UMA Discrete UMA Models
150 – 199

UMA Models
100 – 149

 Supports Microsoft Premium
requirements

√ √ √ √

 Altec Lansing speakers √ √ √ √

Modem Support for optional high-speed 56k
modem

√ √ √ √

Ethernet Integrated 10/100 network interface
card (NIC)

√ √ √ √

Wireless Integrated wireless local area
network (WLAN) options by way of
wireless module:

    

 Intel Centrino Wireless-N 1000
802.11b/g 1x2

√ √ √  

 Intel Centrino Wireless-N 1000
802.11b/g 1x2 plus Broadcom 2070
Bluetooth 2.1+EDR Adapter

√ √ √  

 Atheros AR9285 802.11b/g/n 1x1
WiFi Adapter

√ √ √ √

 Atheros AR9285 802.11b/g/n 1x1
WiFi Adapter plus Broadcom 2070
Bluetooth 2.1+EDR Adapter

√ √ √ √

 Broadcom 4312G 802.11b/g WiFi
Adapter

   √

 Broadcom 4312G 802.11b/g WiFi
Adapter plus Broadcom 2070
Bluetooth 2.1+EDR Adapter

   √

 Realtek RTL8191SE 802.11b/g/n 1x1
WiFi Adapter

√ √ √ √

 Realtek RTL8191SE 802.11b/g/n 1x1
WiFi Adapter plus Broadcom 2070
Bluetooth 2.1+EDR Adapter

√ √ √ √

External media
card

5-in-1 Digital Media Slot; supports
SD, MMC, MS, Mspro, xD

√ √ √ √

 Single port configured as either
HDMI or 5-in-1 Digital Media Slot

√ √ √  

 Supports mini versions of SD, MMC,
and MS Duo with adapter (adapter
not included)

√ √ √ √

Ports VGA (Dsub 15-pin) supporting 1600
x 1200 resolution at 75 Hz; disabled
when connected to devices through
Expansion port 3

√ √ √ √

 Hot plug/unplug and auto detect for
wide-aspect or standard-aspect video

√ √ √ √
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Category Description HP G42 Compaq
Presario

CQ42

Compaq
Presario

CQ42

Compaq
Presario

CQ42

UMA Discrete UMA Models
150 – 199

UMA Models
100 – 149

 HDMI v1.3 supporting 1080p with
HDCP key

√ √ √ √

 Single port configured for either
HDMI or 5-in-1 card reader

√ √ √  

 USB 2.0 (3) √ √ √ √

 RJ-11 (modem) with modem option √ √ √ √

 RJ-45 (Ethernet, with link and activity
lights)

√ √ √ √

 Audio-in (mono microphone) √ √ √ √

 Audio-out (stereo headphone) √ √ √ √

 Smart-pin AC adapter plug √ √ √ √

Keyboard/
pointing devices

14.0-inch keyboard √ √ √  

 TouchPad with 2 buttons and 2-way
scroll (taps enabled as default)

√ √ √  

Power
requirements

6-cell (47-Wh) 2.20-Ah Li-ion battery √ √ √ √

 65-W AC adapter with Smart-Pin DC
connector

√  √ √

 90-W AC adapter with Smart-Pin DC
connector

 √   

Security Security cable slot √ √ √ √

Operating system Preinstalled:     

 Windows 7 Professional (32 & 64 bit) √ √ √  

 Windows 7 Home Premium (32 & 64
bit)

√ √ √

 Windows 7 Home Basic (32 & 64 bit)  √ √  

 Windows 7 Starter (32 bit)  √ √  

 Free DOS  √ √ √

 Novell Linux  √ √  

Serviceability End-user replaceable parts:     

 AC adapter √ √ √ √

 Battery (system) √ √ √ √

 Hard drive √ √ √ √

 Memory module √ √ √ √
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Category Description HP G42 Compaq
Presario

CQ42

Compaq
Presario

CQ42

Compaq
Presario

CQ42

UMA Discrete UMA Models
150 – 199

UMA Models
100 – 149

 Optical drive √ √ √ √

 Mini-card device √ √ √ √
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2 External component identification

Identifying the hardware
Components included with the computer may vary by region and model. The illustrations in this
chapter identify the standard features on most computer models.

To see a list of hardware installed in the computer, follow these steps:

1. Select Start > My Computer.

2. In the left pane of the System Tasks window, select View system information.

3. Select Hardware tab > Device Manager.

You can also add hardware or modify computer configurations using Device Manager.

8 Chapter 2   External component identification



Top components

TouchPad

Component Description

(1) TouchPad off indicator To switch the TouchPad zone on and off, quickly double-tap
the TouchPad off indicator.

NOTE: When the TouchPad zone is active, the light is off.

(2)  TouchPad zone Moves the pointer and selects or activates items on the
screen.

(3)  Left TouchPad button Functions like the left button on an external mouse.

(4)  Right TouchPad button Functions like the right button on an external mouse.

There is an unmarked scroll zone inside the right edge of the TouchPad. To scroll up and down using
the TouchPad vertical scroll zone, slide your finger up or down inside the right edge of the TouchPad.
For more information about TouchPad features, refer to” Using the TouchPad” section later in this
guide.
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Lights

Component Description

(1)  TouchPad light ● On: The TouchPad is disabled.

● Off: The TouchPad is enabled.

(2)  Caps lock light On: Caps lock is on.

(3) Power light ● On: The computer is on.

● Blinking: The computer is in the Sleep state.

● Off: The computer is off or in Hibernation.

(4) Wireless light ● White: An integrated wireless device, such as a
wireless local area network (WLAN) device and/or a
Bluetooth® device, is on.

● Amber: All wireless devices are off.
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Button and speakers

Component Description

(1)  Speakers (2) Produce sound.

(2)  Power button ● When the computer is off, press the button to turn on the
computer.

● When the computer is on, press the button briefly to
initiate Sleep.

● When the computer is in the Sleep state, briefly press
the button to exit Sleep.

● When the computer is in Hibernation, briefly press the
button to exit Hibernation.

If the computer has stopped responding and Windows®
shutdown procedures are ineffective, press and hold the
power button for at least 5 seconds to turn off the computer.

To learn more about your power settings, select Start >
Control Panel > System and Security > Power Options.
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Keys

Component Description

(1)  esc key Displays system information when pressed in combination with
the fn key.

(2)  fn key Displays system information when pressed in combination with
the esc key.

(3) Windows logo key Displays the Windows Start menu.

(4) Windows applications key Displays a shortcut menu for items beneath the pointer.

(5)  Navigation keys Navigate using the Up, Down, Left and Right arrow keys.

(6)  Action keys Execute frequently used system actions.
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Display

Component Description

(1) Internal microphone Records sound.

(2) Integrated webcam (select models only) Records audio and video and captures still photographs.

(3) Integrated webcam light (select models only) On: The integrated webcam is in use.
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Right-side components

Component Description

(1)  Optical drive Reads and writes to optical discs.

(2)  Optical drive light Blinking: The optical drive is being accessed.

(3) USB port Connects an optional USB device.

(4)  RJ-11 (modem) jack (select models only) Connects a modem cable.

(5)  AC adapter/power/battery light ● White: The computer is connected to external power and
the battery is fully charged.

● Blinking white: The computer is in the Sleep state.

● Amber: A battery is charging.

(6) Power connector Connects an AC adapter.

(7) Security cable slot Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a deterrent,
but it may not prevent the computer from being mishandled or
stolen.
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Left-side components

Component Description

(1) External monitor port Connects an external VGA monitor or projector.

(2)  Vent Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal for
the internal fan to cycle on and off during routine operation.

(3)  HDMI port (select models only) Connects an optional video or audio device, such as a high-
definition television, or any compatible digital or audio
component.

(4) RJ-45 (network) jack Connects a network cable.

(5) USB ports (2) Connects optional USB devices.

(6) Audio-in (microphone) jack Connects an optional computer headset microphone, stereo
array microphone, or monaural microphone.

(7) Audio-out (headphone) jack Produces sound when connected to optional powered stereo
speakers, headphones, earbuds, a headset, or television
audio.

(8)  Digital Media Slot (select models only) Supports the following optional digital card formats:

● Memory Stick (MS)

● Memory Stick Pro (MSP)

● MultiMediaCard (MMC)

● Secure Digital (SD) Memory Card

● xD-Picture Card (XD)

(9) Drive light On: The hard drive is in use.
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Bottom components

Component Description

(1)  Battery bay Holds the battery.

(2) Battery release latch Releases the battery from the battery bay.

(3)  Vents (4) Enable airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.

(4) Memory module compartment Contains 2 memory module slots and, on select models,
the wireless LAN (WLAN) device.

CAUTION: To prevent an unresponsive system, replace
the wireless module only with a wireless module
authorized for use in the computer by the governmental
agency that regulates wireless devices in your country or
region. If you replace the module and then receive a
warning message, remove the module to restore computer
functionality, and then contact technical support through
Help and Support.

(5) Hard drive bay Holds the hard drive.
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Wireless antennas
At least 2 antennas send and receive signals from one or more wireless devices. These antennas are
not visible from the outside of the computer.

NOTE: For optimal transmission, keep the areas immediately around the antennas free from
obstructions.

To see wireless regulatory notices, refer to the section of the Regulatory, Safety and Environmental
Notices that applies to your country or region. These notices are located in Help and Support.

Wireless antennas 17



Additional hardware components

Component Description

(1) Power cord* Connects an AC adapter to an AC outlet.

(2) AC adapter Converts AC power to DC power.

(3) Battery* Powers the computer when the computer is not plugged into
external power.

*Power cords vary in appearance by country or region.

WARNING! Connecting the internal analog modem to a digital line can permanently damage the
modem. Immediately disconnect the modem cable if you accidentally connect it to a digital line.

NOTE: Telephone jacks vary by country or region. To use the modem and the modem cable
(included with select models only) outside the country or region in which you purchased the
computer, you must obtain a country- or region-specific modem cable adapter (included with select
models or purchased separately). The modem must be connected to an analog telephone line using a
6-pin, RJ-11 modem cable (included with select models only). Jacks for digital PBX systems may
resemble analog telephone jacks, but they are not compatible with the modem.

If the modem cable contains noise suppression circuitry, which prevents interference from TV and
radio reception, orient the circuitry end of the cable toward the computer.
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3 Illustrated parts catalog

Serial number location
When ordering parts or requesting information, provide the computer serial number and model
number located in the battery bay of the computer.
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Computer major components

Item Description Spare part number

(1) 35.6 cm (14-in), WXGA, BrightView display assembly

NOTE: See Display assembly components on page 26 for more display assembly
internal component spare part information.

 

 ● For use with integrated microphone and webcam; Presario, matte black 592146-001
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Item Description Spare part number

 ● For use with integrated microphone and webcam; Presario, biscotti 597617-001

 ● For use with integrated microphone and webcam; HP, biscotti 600163-001

 ● For use with integrated microphone and webcam; HP, silver (for model 1.0 only) 606155-001

 ● For use with integrated microphone and webcam; HP, white 606156-001

 ● For use with integrated microphone and webcam; HP, charcoal (for model 1.1 only) 622571-001

(2) Keyboards

 ● For use in Brazil (for model 1.1 only) 600175-201

 ● For use in English and French Canada 600175-121

 ● For use in Latin America 600175-161

 ● For use in South Korea 600175-AD1

 ● For use in Taiwan 600175-AB1

 ● For use in Thailand 600175-281

 ● For use in the United States 600175-001

(3) Top cover (includes Touchpad, bracket, button board, and cable)  

 ● Matte black color 600181-001

 ● Biscotti color 600182-001

 ● Silver color 606161-001

 ● White color (for model 1.0 only) 606162-001

 ● Charcoal color (for model 1.1 only) 622581-001

(4) Power button board (includes cable) 600188-001

(5) Touchpad button board (includes cable) 604603-001

(6) Thermal module — fan and heat assembly (includes thermal material)  

 ● For use in models that use Universal Memory Architecture (UMA) graphics
subsystem memory

606609-001

 ● For use in models that use discrete graphics subsystem memory 606610-001

 ● For use in models that use DSC HD545V graphics subsystem memory (for model
1.0 only)

617029-001

(7) Speaker assembly (includes cable) 600189-001

(8) System boards (includes replacement thermal material)

 ● For use in models with DSC HD5430 MDM CR (for model 1.0 only) 592811-001

 ● For use in models with UMA graphics subsystem memory, 592808-001

 ● For use in models with DSC HD5430 (for model 1.0 only) 592810-001

 ● For use in models with UMA graphics subsystem memory and a modem and HDMI
card reader

592809-001

 ● For use in models with HD545V DSC (for model 1.0 only) 611554-001
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 ● For use in models with HD545V DSC CR (for model 1.0 only) 611555-001

 ● For use in models with HD5470/512 MB DSC (for model 1.1 only) 616405–001

 ● For use in models with HD5470/512 MB DSC HDMI (for model 1.1 only) 616406–001

 ● For use in models with HD5470/1G DSC (for model 1.1 only) 616407–001

 ● For use in models with HD5470/1G DSC HDMI (for model 1.1 only) 616408–001

(9) Plastics Kit (see Plastics Kit on page 28 for more Plastics Kit information) 600190-001

 (9a) Hard drive compartment cover

 (9b) Wireless/memory module mini-card compartment cover

(10) RTC battery (includes mounting adhesive) 602745-001

(11) Memory modules

 ● 2-MB, PC3-10600, 1333-MHz 598856-001

 ● 1-MB, PC3-10600, 1333-MHz 598859-001

 ● 4-MB, PC3-10600, 1333-MHz (for model 1.1 only) 599092-001

(12) Modem module  

 ● High-speed 56K modem for use in all countries and regions except Australia and
New Zealand (for model 1.0 only)

510100-001

 ● High-speed 56K modem for use in Australia and New Zealand (for model 1.0 only) 510100-011

(13) WLAN module

 Atheros AR9285 802.11 a/b/g/n 2x2 WiFi adapter  

 ● For use in Canada, the Cayman Islands, Guam, Puerto Rico, the United States, and
the US Virgin Islands

580101-001
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 ● Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda, Argentian,
Armenia, Australia, Austria, Azerbaijan, Bahamas, Bahrain, Barbados, Belgium,
Belize, Benin, Bhutan, Bosnia and Herzegovina, Botswana, Brazil, Brunei, Bulgeria,
Burkina Faso, Burundi, Cambodia, Cameroon, Cape Verde, Central African
Republic, Chad, Chile, China, Colombia, Comoros, Congo, Costa Rica, Croatia,
Cyprus, Czech Republic, Zaire, Denmark, Djibouti, Dominica, Dominican Republic,
Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji,
Finland, France, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece,
Grenada, Guatemala, Guinea, Guinea-Bissa, Guyana, Haiti, Honduras, Hong Kong,
Hungary, Iceland, India, Indonesia, Ireland, Italy, Ivory Coast, Jamaica, Japan,
Jordan, Kazakhstan, Kenya, Kiribati, Korea-South, Kuwait, Kyrgyzstan, Laos, Latvia,
Lebanon, Lesotho, Liberia, Martinique, Nether Antilles, French Guiana, Aruba, British
Virgin Islands, Bermuda, Syria, Guadeloupe, Liechtenstein, Lithuania, Luxembourg,
Macedonia, Madagaascar, Malawi, Malaysia, Maldives, Mali, Malta, Marshall
Islands, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro,
Morocco, Mozambique, Namibia, Nauru, Nepal, Netherlands, New Zealand,
Nicaragua, Niger, Nigeria, Norway, Oman, Palau, Panama, Papua New Guinea,
Paraguay, Peru, Philippines, Poland, Portugal, Republic of Moldova, Romania,
rwanda, Samoa, San Marino, Sao tome and Principe, Saudi Arabia, Senegal, Serbia
and Montenegro, Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, Solomon
Islands, Somalia, South Africa, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St.
Vincent and Gren, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan,
Tanzania, Thailand, Timor (East), Togo, Tonga, Trinidad and Tobago, Tunisia,
Turkey, Turkmenistan, Tuvalu, Uganda, United Arab Emirates ,United Kingdom,
Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zambia, and
Zimbabwe

580101-002

 Realtek RTL8191SE 802.11b/g/n 1x1 WiFi Adapter 593533-001

 SPS-WLAN BGN + BT HMC Combo Matador 600370-001

 SPS-WLAN 802.11 bgn Shiraz HMC 593836-001

 SPS-WLAN BGN (1x1) + BT HMC Combo Rashi 602992-001

(14) Processor (includes replacement thermal material)

 ● Advanced Micro Devices (AMD) processor P320 DDR3-1066 Mhz 594165-001

 ● Advanced Micro Devices (AMD) processor DDR3-1066 Mhz (for model 1.0 only) 594171-001

 ● Advanced Micro Devices (AMD) processor P520 DDR3-1066 Mh 594173-001

 ● Advanced Micro Devices (AMD) processor DC N330 2.3GHz 1M L2 35W (for model
1.0 only)

594164-001

 ● Advanced Micro Devices (AMD) processor DC N530 DC 2.5GHz L2 35W 594172-001

 ● Advanced Micro Devices (AMD) processor DC P820 Tri-Core 1.8Ghz 1.5M L2 25W 594167-001

 ● Advanced Micro Devices (AMD) processor N620 DDR3-1333 Mhz 594166-001

 ● Intel Core 2 Duo Mobile,T4300, 2.1-GHz 572929-001

 ● Intel Core 2 Duo Mobile processor T3100 - 1.9-GHz 572925-001

 ● Intel Core 2 Duo Mobile processor T3300 2.0-GHz 592399-001

 ● Intel Core 2 Duo Mobile processor T4500 2.3-GHz 591880–001

 ● Advanced Micro Devices (AMD) processor P320 DDR3-1066 Mhz 594165-001

 ● Advanced Micro Devices (AMD) processor DDR3-1066 Mhz (for model 1.0 only) 594171-001

 ● Advanced Micro Devices (AMD) processor P520 DDR3-1066 Mh 594173-001
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 ● Advanced Micro Devices (AMD) processor DC N330 2.3GHz 1M L2 35W (for model
1.0 only)

594164-001

 ● Advanced Micro Devices (AMD) processor DC QC P920 1.6Ghz 2M L2 25W 594170-001

 ● Advanced Micro Devices (AMD) processor DC N530 DC 2.5GHz L2 35W 594172-001

 ● Advanced Micro Devices (AMD) processor DC P820 Tri-Core 1.8Ghz 1.5M L2 25W 594167-001

 ● Advanced Micro Devices (AMD) processor N620 DDR3-1333 Mhz 594166-001

 ● Advanced Micro Devices (AMD) processor DC N930 QC 2.0 GHz 594169-001

 ● Advanced Micro Devices (AMD) processor DC N830 Tri-core 2.1Ghz 1.5M L2 35W 594168-001

 ● Advanced Micro Devices (AMD) processor DC P340 2.2GHz L2 25W (for model 1.1
only)

616343-001

 ● Advanced Micro Devices (AMD) processor DC N350 2.4GHz L2 35W (for model 1.1
only)

616334-001

 ● Advanced Micro Devices (AMD) processor DC P540 DC 2.4GHz L2 25W (for model
1.1 only)

616347-001

 ● Advanced Micro Devices (AMD) processor DC N550 DC 2.6GHz L2 35W (for model
1.1 only)

616337-001

 ● Advanced Micro Devices (AMD) processor DC N640 DC 2.9Ghz L2 35W (for model
1.1 only)

616344-001

 ● Advanced Micro Devices (AMD) processor DC P840 1.9Ghz L2 (for model 1.1 only) 616335-001

 ● Advanced Micro Devices (AMD) processor DC N850 2.2Ghz L2 (for model 1.1 only) 616345-001

 ● Advanced Micro Devices (AMD) processor DC P940 DC QC 1.7Ghz L2 (for model
1.1 only)

616336-001

 ● Advanced Micro Devices (AMD) processor DC P950 QC 2.1Ghz L2 35W (for model
1.1 only)

616346-001

(15) USB board (includes cable) 600631-001

(16) Modem (RJ-11) cable (includes RJ-11 connector with modem cable) 610791-001

(17) Power connector cable (includes power connector and cable) 600630-001

(18) Base enclosure (with modem cable and ODD cable)  

 ● For use with HDMI card reader, biscotti 617025-001

 ● For use without HDMI card reader, biscotti 617026-001

 ● For use with HDMI card reader and without modem module, silver 608912-001

 ● For use with HDMI card reader and without modem, white (for model 1.0 only) 608913-001

 ● For use with HDMI card reader, matte black 617027-001

 ● For use without HDMI card reader, matte black 617028-001

 ● For use with HDMI card reader, charcoal (for model 1.1 only) 622579-001

(19) Bluetooth module 537921-001

 Bluetooth module cable (illustrated with Bluetooth module) 602822-001

(20) Battery
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 ● 6-cell 47-WH (2.2-Ah) LI-ion 593553-001

 ● 6-cell 55-WH (2.55-Ah) LI-ion 593554-001

(21) Hard drive (include hard drive bracket)

 ● 640-GB 5400 RPM 603785-001

 ● 500-GB 7200 RPM 600170-001

 ● 320-GB 7200 RPM 600169-001

 ● 250-GB 7200 RPM 575598-001

 ● 160-GB 7200 RPM 600167-001

(22) Hard drive cable/adapter (included with the cable kit; see Mass storage devices
on page 29)

610791–001

(23) Optical drive cable (included in the cable kit) 610791-001

(24) Optical drives (12.7 mm, SATA, fixed)

 ● Blu-ray Disc ROM LightScribe with SuperMulti DVD±R/RW Double-Layer, matte
black

600173-001

 ● Blu-ray Disc ROM LightScribe with SuperMulti DVD±R/RW Double-Layer, biscotti 600174-001

 ● Blu-ray Disc ROM LightScribe with SuperMulti DVD±R/RW Double-Layer, silver 608121-001

 ● Blu-ray Disc ROM LightScribe with SuperMulti DVD±R/RW Double-Layer, white (for
model 1.0 only)

608122-001

 ● Blu-ray Disc ROM LightScribe with SuperMulti DVD±R/RW Double-Layer, charcoal
(for model 1.1 only)

622577-001

 ● DVD±RW SuperMulti DL Drive with LightScribe, matte black 600171-001

 ● DVD±RW SuperMulti DL Drive with LightScribe, biscotti 600172-001

 ● DVD±RW SuperMulti DL Drive with LightScribe, silver 608119-001

 ● DVD±RW SuperMulti DL Drive with LightScribe, white (for model 1.0 only) 608120-001

 ● DVD±RW SuperMulti DL Drive with LightScribe, charcoal (for model 1.1 only) 622575-001
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Display assembly components

Item Description Spare part number

(1) Display bezel  

 ● HP, for use with microphone and webcam 592147-001

 ● Presario, for use with microphone and webcam 592148-001

(2) 35.6 cm (14-in) high definition, Brightview, display panel (includes display panel cable) 592144-001

(3) Display hinge cover 592150-001

 Display bracket (with hinges) 600627-001

 Display cable kit 592151-001

 Display cable (shown with display panel)  
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 (4) Webcam cable  

 (5) Antennas and cables  

(6) Display back cover  

 ● Presario, matte black 592149-001

 ● Presario, biscotti 600164-001

 ● HP, biscotti 600165-001

 ● HP, silver 606157-001

 ● HP, white (for model 1.0 only) 606158-001

 ● HP, charcoal (for model 1.1 only) 622573-001

(7) Webcam module 600166-001

 Display screw kit (not illustrated; includes screws and screw covers) 592152-001

 Display rubber display kit (not illustrated) 595198-001

Display assembly components 27



Plastics Kit

Item Description Spare part number

 Plastics kit 600190-001

(1) Hard drive bay cover (includes captive screws)  

(2) Wireless/memory module mini-card compartment cover (includes captive screw)  

28 Chapter 3   Illustrated parts catalog



Mass storage devices

Item Description Spare part number

(1) Hard drive (include hard drive bracket)

 ● 640–GB 5400 RPM 603785-001

 ● 500-GB 7200 RPM 600170-001

 ● 320-GB 7200 RPM 600169-001

 ● 250-GB 7200 RPM 575598-001

 ● 160-GB 7200 RPM 600167-001

 Hard drive hardware kit (contains screws, hard drive bracket, not illustrated) 513771-001

 Hard drive cable/adapter (included in the cable kit) 610791–001

(2) Optical drives (12.7 mm, SATA, fixed)

 ● Blu-ray Disc ROM LightScribe with SuperMulti DVD±R/RW Double-Layer, matte
black

600173-001

 ● Blu-ray Disc ROM LightScribe with SuperMulti DVD±R/RW Double-Layer, biscotti 600174-001

 ● Blu-ray Disc ROM LightScribe with SuperMulti DVD±R/RW Double-Layer, silver 608121-001

 ● Blu-ray Disc ROM LightScribe with SuperMulti DVD±R/RW Double-Layer, white (for
model 1.0 only)

608122-001

 ● Blu-ray Disc ROM LightScribe with SuperMulti DVD±R/RW Double-Layer, charcoal
(for model 1.1 only)

622577-001

 ● DVD±RW SuperMulti DL Drive with LightScribe, matte black 600171-001

 ● DVD±RW SuperMulti DL Drive with LightScribe, biscotti 600172-001

 ● DVD±RW SuperMulti DL Drive with LightScribe, silver 608119-001

 ● DVD±RW SuperMulti DL Drive with LightScribe, white (for model 1.0 only) 608120-001

 ● DVD±RW SuperMulti DL Drive with LightScribe, charcoal (for model 1.1 only) 622575-001
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Miscellaneous parts

Description Spare part number

AC adapters

● 90-W Smart AC adapter with power factor correction (PFC) 613152-001

● 90-W AC adapter with power factor correction (PFC) 613160-001

● 65-W AC Smart, slim, AC adapter 613153-001

● 65-W Smart power adapter with power factor correction (PFC) for use in India 613161-001

Power cord, AC, 3 wire, black, 1.83-m

● For use in Argentina 490371-D01

● For use in Australia 490371-011

● For use in Brazil 490371-202

● For use in India 490371-D61

● For use in Italy 490371-061

● For use in North America 490371-001

● For use in South Korea 490371-AD1

● For use in Taiwan 490371-AB1

● For use in Thailand 490371-201

● For use in the People's Republic of China 490371-AA1

● For use in the United Kingdom and Singapore 490371-031

Rubber kit 600184-001

Screw kit

● Phillips M2.0x3.0 screw

● Phillips M2.5x3.0 screw

● Phillips M2.5x4.0 screw

● Phillips M2.5x5.0 screw

● Phillips M2.5x6.5 screw

595202-001
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Spare part
number
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490371-001 Power cord, AC, 3-pin, black, 1.83-m, for use in North America

490371-011 Power cord, AC, 3-pin, black, 1.83-m, for use in Australia

490371-031 Power cord, AC, 3-pin, black, 1.83-m, for use in the United Kingdom and Singapore

490371-061 Power cord, AC, 3-pin, black, 1.83-m, for use in Italy

490371-201 Power cord, AC, 3-pin, black, 1.83-m, for use in Thailand

490371-202 Power cord, AC, 3-pin, black, 1.83-m, for use in Brazil

490371-AA1 Power cord, AC, 3-pin, black,1.83-m, for use in the People's Republic of China

490371-AB1 Power cord, AC, 3-pin, black,1.83-m, for use in Taiwan

490371-AD1 Power cord, AC, 3-pin, black,1.83-m, for use in South Korea

490371-D01 Power cord, AC, 3-pin, black,1.83-m, for use in Argentina

490371-D61 Power cord, AC, 3-pin, black,1.83-m, for use in India

510100-001 Modem module, high-speed 56K modem for use in all countries and regions except Australia and New
Zealand (for model 1.0 only)

510100-011 Modem module, high-speed 56K modem for use in Australia and New Zealand (for model 1.0 only)

513771-001 Hard drive hardware kit (screws and hard drive bracket)

537921-001 Bluetooth module without cable

575598-001 Hard disk drive, 250-GB 7200 RPM

580101-001 Atheros AR9285 802.11 a/b/g/n 2x2 WiFi adapter for use in Canada, the Cayman Islands, Guam,
Puerto Rico, the United States, and the US Virgin Islands

580101-002 Atheros AR9285 802.11 a/b/g/n 2x2 WiFi adapter for use in Afghanistan, Albania, Algeria, Andorra,
Angola, Antigua and Barbuda, Argentina, Armenia, Australia, Austria, Azerbaijan, Bahamas, Bahrain,
Barbados, Belgium, Belize, Benin, Bhutan, Bosnia and Herzegovina, Botswana, Brazil, Brunei,
Bulgaria, Burkina Faso, Burundi, Cambodia, Cameroon, Cape Verde, Central African Republic, Chad,
Chile, China, Colombia, Comoros, Congo, Costa Rica, Croatia, Cyprus, Czech Republic, Zaire,
Denmark, Djibouti, Dominica, Dominican Republic, Ecuador, Egypt, El Salvador, Equatorial Guinea,
Eritrea, Estonia, Ethiopia, Fiji, Finland, France, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar,
Greece, Grenada, Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong,
Hungary, Iceland, India, Indonesia, Ireland, Italy, Ivory Coast, Jamaica, Japan, Jordan, Kazakhstan,
Kenya, Kiribati, Korea-South, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Martinique,
Nether Antilles, French Guiana, Aruba, British Virgin Islands, Bermuda, Syria, Guadeloupe,
Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, Maldives, Mali,
Malta, Marshall Islands, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro,
Morocco, Mozambique, Namibia, Nauru, Nepal, Netherlands, New Zealand, Nicaragua, Niger, Nigeria,
Norway, Oman, Palau, Panama, Papua New Guinea, Paraguay, Peru, Philippines, Poland, Portugal,
Republic of Moldova, Romania, Rwanda, Samoa, San Marino, Sao tome and Principe, Saudi Arabia,
Senegal, Serbia and Montenegro, Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, Solomon
Islands, Somalia, South Africa, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and Gren,
Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Thailand, Timor (East),
Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, United Arab
Emirates, United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zambia, and
Zimbabwe

592144-001 Display panel, 35.6 cm (14-in) high definition, Brightview
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592146-001 35.6 cm (14-in) WXGA Brightview display assembly for use with integrated microphone and webcam;
Presario, matte black

592147-001 Display bezel, HP, for use with microphone and webcam

592148-001 Display bezel, Presario, for use with microphone and webcam

592149-001 Display back cover, Presario, matte black

592150-001 Display hinge cover

592151-001 Display cable kit

592152-001 Display screw kit (not illustrated)

592808-001 For use in system boards with UMA

592809-001 For use in system boards with UMA MDM CR

592810-001 For use in system boards with HD5430 DSC

592811-001 For use in system boards with HD5430 DSC MDM CR

593533-001 Realtek RTL8191SE 802.11b/g/n 1x1 WiFi Adapter

593553-001 Battery, 6-cell 47-WH (2.2-Ah) LI-ion

593554-001 Battery, 6-cell 55-WH (2.55Ah) LI-ion

593836-001 SPS-WLAN 802.11 bgn Shiraz HMC

594164-001 Processor Advanced Micro Devices (AMD) DC N330 2.3GHz 1M L2 35W

594165-001 Processor Advanced Micro Devices (AMD) P320 DDR3-1066 Mhz

594166-001 Processor Advanced Micro Devices (AMD) N620 35W DDR3-1333 Mhz

594167-001 Processor Advanced Micro Devices (AMD) DC P820 Tri-Core 1.8Ghz 1.5M L2 25W

594168-001 Processor Advanced Micro Devices (AMD) DC N830 Tri-core 2.1Ghz 1.5M L2 35W

594169-001 Processor Advanced Micro Devices (AMD) DC N930 QC 2.0 GHz

594170-001 Processor Advanced Micro Devices (AMD) DC QC P920 1.6Ghz 2M L2 25W

594171-001 Advanced Micro Devices (AMD) processor V120 DDR3-1066 Mhz

594172-001 Processor Advanced Micro Devices (AMD) DC N530 2.5GHz DDR3-1333 Mhz

594173-001 Processor Advanced Micro Devices (AMD) P520 DDR3-1066 Mhz

595198-001 Display rubber kit

595202-001 Screw kit

597617-001 35.6 cm (14-in) WXGA Brightview display assembly for use with integrated microphone and webcam;
Presario, biscotti

598856-001 Memory module, 2-GB, PC3 10600, 1333-MHz

598859-001 Memory module, 1-GB, PC3 10600, 1333-MHz

599092-001 Memory module, 4-GB, PC3 10600, 1333-MHz

600163-001 35.6 cm (14-in) WXGA Brightview display assembly for use with integrated microphone and webcam;
HP, biscotti
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600164-001 Display back cover, Presario, biscotti

600165-001 Display back cover, HP, biscotti

600166-001 Webcam module

600167-001 Hard disk drive, 160-GB 7200 RPM

600169-001 Hard disk drive, 320-GB 7200 RPM

600170-001 Hard disk drive, 500-GB 7200 RPM

600171-001 Optical drive, DVD±RW SuperMulti DL Drive with LightScribe, matte black

600172-001 Optical drive, DVD±RW SuperMulti DL Drive with LightScribe, biscotti

600173-001 Optical drive, Blu-ray Disc ROM LightScribe with SuperMulti DVD±R/RW Double-Layer, matte black

600174-001 Optical drive, Blu-ray Disc ROM LightScribe with SuperMulti DVD±R/RW Double-Layer, biscotti

600175-001 Keyboard for use in the United States

600175-121 Keyboard for use in English and French Canada

600175-161 Keyboard for use in Latin America

600175-201 Keyboard for use in Brazil

600175-281 Keyboard for use in Thailand

600175-AB1 Keyboard for use in Taiwan

600175-AD1 Keyboard for use in South Korea

600181-001 Top cover (includes Touchpad and bracket, button board, and cable), matte black color

600182-001 Top cover (includes Touchpad and bracket, button board, and cable) , bicotti color

600184-001 Rubber kit

600188-001 Power button board (includes cable)

600189-001 Speaker assembly (includes cable)

600190-001 Plastics kit (with hard drive compartment cover and memory/wireless compartment cover)

600370-001 SPS-WLAN BGN + BT HMC Combo Matador

600627-001 Display bracket (with hinges)

600630-001 Power connector with cable

600631-001 USB board with cable

602745-001 RTC battery

602992-001 SPS-WLAN BGN (1x1) + BT HMC Combo Rashi

603785-001 Hard disk drive, 640-GB 5400 RPM

604603-001 Touchpad board (includes cable)

606155–001 35.6 cm (14-in) WXGA Brightview display assembly for use with integrated microphone and webcam;
HP, silver
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606156–001 35.6 cm (14-in) WXGA Brightview display assembly for use with integrated microphone and webcam;
HP, white (for model 1.0 only)

606157–001 Display back cover, HP, silver

606158–001 Display back cover, HP, white (for model 1.0 only)

606161-001 Top cover (includes Touchpad and bracket, button board, and cable) , silver color

606162-001 Top cover (includes Touchpad and bracket, button board, and cable), white color

606609-001 Thermal module (includes fan and heat sink) for use in models that use UMA graphics subsystem
memory

606610-001 Thermal module (includes fan and heat sink) for use in models that use discrete graphics subsystem
memory

608119-001 Optical drive, DVD±RW SuperMulti DL Drive with LightScribe, silver

608120-001 Optical drive, DVD±RW SuperMulti DL Drive with LightScribe, white

608121-001 Optical drive, Blu-ray Disc ROM LightScribe with SuperMulti DVD±R/RW Double-Layer, silver

608122-001 Optical drive, Blu-ray Disc ROM LightScribe with SuperMulti DVD±R/RW Double-Layer, white

608912-001 Base enclosure (with modem cable and ODD cable) for use with HDMI card reader and without modem
module, silver

608913-001 Base enclosure (with modem cable and ODD cable) for use with HDMI card reader and without
modem, white

610791-001 Optical drive cable (included in the cable kit)

610791–001 Modem (RJ–11 cable with modem connector included in the cable kit)

610791–001 Hard drive cable/adaptor (included in the cable kit)

611554-001 For use in systems boards with HD545V DSC

611555-001 For use in system boards with HD545V DSC CR

613152-001 65-W Smart AC adapter

613153-001 90-W AC adapter with power factor correction (PFC)

613160-001 90-W AC adapter RC/V EM, with power factor correction (PFC)

613161-001 65-W AC adapter with power factor correction (PFC) for use in India

616334-001 Processor Advanced Micro Devices (AMD) DC N350 2.4GHz 35W

616335-001 Processor Advanced Micro Devices (AMD) P840 1.9GHz

616336-001 Processor Advanced Micro Devices (AMD) DC QC P940 1.7GHz

616337-001 Processor Advanced Micro Devices (AMD) DC N550 2.6GHz 35W

616343-001 Processor Advanced Micro Devices (AMD) DC P340 2.2GHz 25W

616344-001 Processor Advanced Micro Devices (AMD) N640 2.9GHz 35W

616345-001 Processor Advanced Micro Devices (AMD) N850 2.2GHz

616346-001 Processor Advanced Micro Devices (AMD) QC N950 2.1GHz 35W

616347-001 Processor Advanced Micro Devices (AMD) DC P540 2.4GHz 25W
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616405–001 System board for use in models with discrete graphics subsystem HD5470/512 MB

616406–001 System board for use in models with discrete graphics subsystem HD5470/512 MB with HDMI card
reader

616407–001 System board for use in models with discrete graphics subsystem HD5470/1 G

616408–001 System board for use in models with discrete graphics subsystem HD5470/1 G with HDMI card reader

617025-001 Base enclosure (with modem cable and ODD cable) for use with HDMI card reader, biscotti

617026-001 Base enclosure (with modem cable and ODD cable), biscotti

617027-001 Base enclosure (with modem cable and ODD cable) for use with HDMI card reader, matte black

617028-001 Base enclosure (with modem cable and ODD cable), matte black

617029-001 Thermal module (includes fan and heat sink) for use in models that use DSC HD545v graphics
subsystem memory

622571–001 35.6 cm (14-in) WXGA Brightview display assembly for use with integrated microphone and webcam;
HP, charcoal

622573-001 Display back cover, HP, charcoal

622575-001 Optical drive, DVD±RW SuperMulti DL Drive with LightScribe, charcoal

622577-001 Optical drive, Blu-ray Disc ROM LightScribe with SuperMulti DVD±R/RW Double-Layer, charcoal

622579-001 Base enclosure (with modem cable and ODD cable) for use with HDMI card reader, charcoal

622581-001 Top cover (includes Touchpad and bracket, button board, and cable) , charcoal color
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4 Removal and replacement procedures

Preliminary replacement requirements

Tools required

You will need the following tools to complete the removal and replacement procedures:

● Flat-bladed screwdriver

● Magnetic screwdriver

● Phillips P0 and P1 screwdrivers

Service considerations

The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.

NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts

Using excessive force during disassembly and reassembly can damage plastic parts. Use care when
handling the plastic parts. Apply pressure only at the points designated in the maintenance
instructions.
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Cables and connectors

CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to
unseat or seat the cables during removal and insertion. Handle cables by the connector whenever
possible. In all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in
such a way that they cannot be caught or snagged by parts being removed or replaced. Handle flex
cables with extreme care; these cables tear easily.

Drive handling

CAUTION: Drives are fragile components that must be handled with care. To prevent damage to
the computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the
computer is off or in Hibernation, turn the computer on, and then shut it down through the operating
system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.

Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers.

Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”
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Grounding guidelines

Electrostatic discharge damage

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some
protection, but in many cases, ESD contains enough power to alter device parameters or melt
silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.

CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.

Use nonmagnetic tools.

Before touching an electronic component, discharge static electricity by using the guidelines
described in this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by different
activities.

CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

 Relative humidity

Event 10% 40% 55%

Walking across carpet 35,000 V 15,000 V 7,500 V

Walking across vinyl floor 12,000 V 5,000 V 3,000 V

Motions of bench worker 6,000 V 800 V 400 V

Removing DIPS from plastic tube 2,000 V 700 V 400 V

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

● To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

● Protect ESD-sensitive parts and assemblies with conductive or approved containers or
packaging.

● Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

● Place items on a grounded surface before removing items from their containers.

● Always be properly grounded when touching a component or assembly.

● Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive
foam.

● Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials
are selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

● Cover the workstation with approved static-shielding material.

● Use a wrist strap connected to a properly grounded work surface and use properly grounded
tools and equipment.

● Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

● When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe
materials.

● Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and
Styrofoam.

● Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

● Avoid contact with pins, leads, or circuitry.

● Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

● When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible
straps with a minimum of one megohm ±10% resistance in the ground cords. To provide proper
ground, wear a strap snugly against the skin at all times. On grounded mats with banana-plug
connectors, use alligator clips to connect a wrist strap.

● When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive strips
must be worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

● Antistatic tape

● Antistatic smocks, aprons, and sleeve protectors

● Conductive bins and other assembly or soldering aids

● Nonconductive foam

● Conductive tabletop workstations with ground cords of one megohm resistance

● Static-dissipative tables or floor mats with hard ties to the ground

● Field service kits

● Static awareness labels

● Material-handling packages

● Nonconductive plastic bags, tubes, or boxes

● Metal tote boxes

● Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level

Antistatic plastic Bags 1,500 V

Carbon-loaded plastic Floor mats 7,500 V

Metallized laminate Floor mats 5,000 V
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Component replacement procedures
This chapter provides removal and replacement procedures.

There are as many as 75 screws, in 12 different sizes, that must be removed, replaced, or loosened
when servicing the computer. Make special note of each screw size and location during removal and
replacement.

Serial number

The serial number label, located in the battery bay of the computer, provides important information
that you may need when contacting technical support.

(1) Product name (4) Warranty period

(2) Serial number (5) Model description (select models)

(3) Product number  
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Computer feet

Description Spare part number

Rubber Feet Kit 600184-001

The computer feet are adhesive-backed rubber pads. The feet attach to the base enclosure in the
locations illustrated below.
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Battery

Description Spare part number

6-cell 55-WH (2.55Ah) LI-ion 593554-001

6-cell 47-WH (2.2-Ah) LI-ion 593553-001

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery:

1. Turn the computer upside down on a flat surface.

2. Slide the battery release latch (1) to release the battery.

3. Pivot the battery (2) upward and lift it out of the computer (3).

To insert the battery, insert the rear edge of the battery into the battery bay and pivot the front edge
downward until the battery is seated. The battery release latch automatically locks the battery into
place.
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Hard drive

NOTE: All hard drive spare part kits include a hard drive bracket.

Description Spare part number

640-GB 5400 RPM 603785-001

500-GB 7200 RPM 600170-001

320-GB 7200 RPM 600169-001

250-GB 7200 RPM 575598-001

160-GB 7200 RPM 600167-001

Hard drive hardware kit (includes screws and hard drive bracket) 513771-001

Hard drive cable/adaptor (included in the cable kit) 610791–001

Before removing the hard drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 43).

Remove the hard drive:

1. Position the computer with the front toward you.

2. Remove the two Phillips PM2.5×5.0 screws (1) that secure the hard drive cover to the computer.
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3. Lift the left side of the hard drive cover (2), swing it forward, and remove the cover (3). The hard
drive cover is included in the plastics kit, spare part number 600190-001.

4. Remove the three Phillips PM2.5×4.0 screws (1) that secure the hard drive to the computer.

5. Use the hard drive bracket to lift the hard drive out (2) of the hard drive compartment.
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6. Disconnect the hard drive cable from the system board.

7. Remove the hard drive.

8. If it is necessary to replace the hard drive bracket, remove the four Phillips PM3.0×3.0 screws
(1) that secure the hard drive bracket to the hard drive

9. Lift the bracket (2) straight up.

Reverse this procedure to install the hard drive.
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Optical drive

Description Spare part
number

DVD±RW SuperMulti DL Drive with LightScribe, matte black 600171-001

DVD±RW SuperMulti DL Drive with LightScribe, biscotti 600172-001

DVD±RW SuperMulti DL Drive with LightScribe, silver 608119-001

DVD±RW SuperMulti DL Drive with LightScribe, white (for model 1.0 only) 608120-001

DVD±RW SuperMulti DL Drive with LightScribe, charcoal (for model 1.1 only) 622575-001

Blu-ray Disc ROM LightScribe with SuperMulti DVD±R/RW Double-Layer, matte black 600173-001

Blu-ray Disc ROM LightScribe with SuperMulti DVD±R/RW Double-Layer, biscotti 600174-001

Blu-ray Disc ROM LightScribe with SuperMulti DVD±R/RW Double-Layer, silver 608121-001

Blu-ray Disc ROM LightScribe with SuperMulti DVD±R/RW Double-Layer, white (for model 1.0 only) 608122-001

Blu-ray Disc ROM LightScribe with SuperMulti DVD±R/RW Double-Layer, charcoal (for model 1.1 only) 622577-001

Before removing the optical drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 43).

Remove the optical drive:

1. Position the computer upside down with the front toward you.

2. Remove the Phillips PM2.5x5.0 screw (1) that secures the optical drive to the computer.

3. Insert a flat-bladed screwdriver or similar tool into the access point through the hard drive
compartment (2), and then push the drive bracket to the left to release the optical drive.
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4. Remove the optical drive (3).

5. If it is necessary to replace the optical drive bracket, position the optical drive with the optical
drive bracket toward you.

6. Remove the two Phillips PM2.0×3.0 screws (1) that secure the optical drive bracket to the optical
drive.

7. Remove the optical drive bracket (2).

Reverse the above procedure to reassemble and install the optical drive.
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WLAN module

Description Spare part
number

Atheros AR9285 802.11 a/b/g/n 2x2 WiFi adapter for use in Canada, the Cayman Islands, Guam,
Puerto Rico, the United States, and the US Virgin Islands

580101-001

Atheros AR9285 802.11 a/b/g/n 2x2 WiFi adapter for use in Afghanistan, Albania, Algeria, Andorra,
Angola, Antigua and Barbuda, Argentian, Armenia, Australia, Austria, Azerbaijan, Bahamas, Bahrain,
Barbados, Belgium, Belize, Benin, Bhutan, Bosnia and Herzegovina, Botswana, Brazil, Brunei,
Bulgeria, Burkina Faso, Burundi, Cambodia, Cameroon, Cape Verde, Central African Republic, Chad,
Chile, China, Colombia, Comoros, Congo, Costa Rica, Croatia, Cyprus, Czech Republic, Zaire,
Denmark, Djibouti, Dominica, Dominican Republic, Ecuador, Egypt, El Salvador, Equitorial Guinea,
Eritrea, Estonia, Ethiopia, Fiji, Finland, France, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar,
Greece, Grenada, Guatemala, Guinea, Guinea-Bissa, Guyana, Haiti, Honduras, Hong Kong, Hungary,
Iceland, India, Indonesia, Ireland, Italy, Ivory Coast, Jamaica, Japan, Jordan, Kazakhstan, Kenya,
Kiribati, Korea-South, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Martinique, Nether
Antilles, French Guiana, Aruba, British Virgin Islands, Bermuda, Syria, Guadeloupe, Liechtenstein,
Lithuania, Luxembourg, Macedonia, Madagaascar, Malawi, Malaysia, Maldives, Mali, Malta, Marshall
Islands, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco,
Mozambique, Namibia, Nauru, Nepal, Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway,
Oman, Palau, Panama, Papua New Guinea, Paraguay, Peru, Philippines, Poland, Portugal, Republic of
Moldova, Romania, rwanda, Samoa, San Marino, Sao tome and Principe, Saudi Arabia, Senegal,
Serbia and Montenegro, Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, Solomon Islands,
Somalia, South Africa, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and Gren, Suriname,
Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Thailand, Timor (East), Togo, Tonga,
Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, United Arab Emirates ,United
Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zambia, and Zimbabwe

580101-002

Realtek RTL8191SE 802.11b/g/n 1x1 WiFi Adapter 593533-001

SPS-WLAN BGN + BT HMC Combo Matador 600370-001

SPS-WLAN 802.11 bgn Shiraz HMC 593836-001

SPS-WLAN BGN (1x1) + BT HMC Combo Rashi 602992-001

Before removing the WLAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 43).

5. Remove the hard drive cover (see Hard drive on page 44).

Remove the WLAN module:

1. Turn the computer upside down with the front toward you.
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2. Loosen the 2 Phillips PM2.5×5.0 captive screws (1) that secure the mini-card compartment
cover.

3. Lift the cover off the computer (2). The mini-card compartment cover is included in the plastics
kit, spare part number 600190-001.

4. Disconnect the two WLAN antenna cables (1) from the WLAN module.

5. Remove the Phillips PM2.0×3.0 screw (2) that secures the WLAN module to the computer. (The
edge of the module opposite the slot rises away from the computer.)

6. Remove the WLAN module (3) by pulling it away from the slot at an angle.

CAUTION: To prevent an unresponsive system, replace the wireless module only with a
wireless module authorized for use in the computer by the governmental agency that regulates
wireless devices in your country or region. If you replace the module and then receive a warning
message, remove the module to restore computer functionality, and then contact technical
support through Help and Support.

NOTE: WLAN modules are designed with a notch (4) to prevent incorrect insertion into the
WLAN module slot.

Reverse this procedure to install a WLAN module.

50 Chapter 4   Removal and replacement procedures



Memory module

Description Spare part number

2–GB, PC3 10600, 1333-MHz 598856-001

1-GB, PC3 10600, 1333-MHz 598859-001

4-GB, PC3 10600, 1333-MHz (for model 1.1 only) 599092-001

Before removing the memory module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 43).

Remove the memory module:

1. Turn the computer upside down with the front toward you.

2. Loosen the two Phillips PM2.5×5.0 captive screws that secure the mini-card compartment cover
to the computer.
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3. Lift cover off the computer. The mini-card compartment cover is included in the plastics kit, spare
part number 600190-001.

NOTE: Small tabs hold the cover in place. Firmly pull up on the cover to release the tabs.

4. Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The edge of the module opposite the slot rises away from the computer.)

5. Remove the module (2) by pulling it away from the slot at an angle.

NOTE: Memory modules are designed with a notch (3) to prevent incorrect insertion into the
memory module slot.

Reverse this procedure to install a memory module.
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Keyboard

Description Spare part number

Keyboard for use in Brazil 600175-201

Keyboard for use in English and French Canada 600175-121

Keyboard for use in for use in Latin America 600175-161

Keyboard for use in South Korea 600175-AD1

Keyboard for use in Taiwan 600175-AB1

Keyboard for use in Thailand 600175-281

Keyboard for use in the United States 600175-001

Before removing the keyboard, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 43).

5. Remove the hard drive (see Hard drive on page 44)

6. Remove the mini-card compartment cover (see WLAN module on page 49).

Remove the keyboard:

1. Turn the computer upside down with the front toward you.

2. Remove the six Phillips PM2.5×6.5 screws that secure the keyboard to the computer.

3. Turn the computer display-side up with the front toward you.

4. Open the computer as far as possible.
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5. Release the top edge of the keyboard by lifting it up to disengage the keyboard from the tabs on
the top cover (1).

6. Slide the top edge of the keyboard back (2) until it rests against the display.

7. Release the zero insertion force (ZIF) connector (1) to which the keyboard cable is attached and
disconnect the keyboard cable (2) from the system board.

8. Remove the keyboard.

Reverse this procedure to install the keyboard.
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Top cover

Description Spare part number

Top cover (includes Touchpad and bracket, button board, and cable), matte black 600181-001

Top cover, bicotti 600182-001

Top cover, silver 606161-001

Top cover, white (for model 1.0 only) 606162-001

Top cover, charcoal (for model 1.1 only) 622581-001

Before removing the switch cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the following components:

a. Battery (see Battery on page 43).

b. Optical drive (see Optical drive on page 47).

c. Keyboard (see Keyboard on page 53).

Remove the switch cover:

1. Turn the computer upside down with the front toward you.

2. Remove the four screw covers (1) at the front edge of the computer.
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3. Remove the five Phillips PM2.5×6.5 screws (2), the two Phillips PM2.5x4.0 screws (3), and the
four Phillips PM2.5x3.0 screws (4) that secure the top cover to the base enclosure.

4. Turn the computer display-side up with the front toward you.

5. Open the computer as far as possible.

6. Release the ZIF connector to which the touchpad (1) is connected and disconnect the cable
from the system board.

7. Release the ZIF connector to which the touchpad button board cable (2) is connected and
disconnect the cable from the system board.

8. Disconnect the speaker cable (3) from the system board.
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9. Release the ZIF connector to which the power button board cable (4) is connector and
disconnect the cable from the system board.

10. Remove the Phillips PM2.5×6.5 screw (1) from the top cover, disengage the rear edge of the top
cover (2) from the base enclosure, and then remove the cover from the computer (3).

Reverse this procedure to install the switch cover.
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Speaker assembly

Description Spare part number

Speaker assembly 600189-001

Before removing the speaker assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 43).

5. Remove the following components:

a. Optical drive (see Optical drive on page 47)

b. Keyboard (see Keyboard on page 53)

c. Top cover (see Top cover on page 55)

Remove the speaker assembly:

1. Turn the top cover upside down.

2. Remove the two Phillips PM2.5×4.0 screws (1) that secure the speaker assembly to the
computer.

3. Lift the speaker assembly (2) straight up to remove it from the top cover.

Reverse this procedure to install the speaker assembly.
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Power button board

Description Spare part number

Power button board (with cable) 600188-001

Before removing the power button board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 43).

5. Remove the following components:

a. Hard drive (see Hard drive on page 44)

b. Optical drive (see Optical drive on page 47)

c. Keyboard (see Keyboard on page 53)

d. Top cover (see Top cover on page 55)

Remove the power button board:

1. Turn the top cover upside down with the rear edge toward you.

2. Remove the Phillips PM2.5×3.0 screw (1) that secures the power button board to the top cover.

3. Remove the power button board (2).
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TouchPad button board

Description Spare part number

TouchPad button board 604603-001

Before removing the TouchPad button board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 43).

5. Remove the following components:

a. Hard drive (see Hard drive on page 44)

b. Optical drive (see Optical drive on page 47)

c. Keyboard (see Keyboard on page 53)

d. Top cover (see Top cover on page 55)

Remove the TouchPad button board:

1. Turn the top cover upside down with the front toward you.

2. Remove the two Phillips PM2.5×3.0 screws (1) that secure the TouchPad board to the top cover.

3. Remove the TouchPad button board (2) from the TouchPad bracket.

Reverse the above procedure to reassemble and install the TouchPad button board.
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Modem module

Description Spare part number

High-speed 56K modem for use in all countries and regions except Australia and New Zealand
(for model 1.0 only)

510100-001

High-speed 56K modem for use in Australia and New Zealand (for model 1.0 only) 510100-011

Modem module cable with RJ-11 connector (included in the cable kit) 610791-001

Before removing the modem module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 43).

5. Remove the following components:

a. Hard drive (see Hard drive on page 44)

b. Optical drive (see Optical drive on page 47)

c. Keyboard (see Keyboard on page 53)

d. Top cover (see Top cover on page 55)

Remove the modem module:

1. Turn the computer upright with the front toward you.

2. Remove the two Phillips PM2.0×3.0 screws (1) that secure the modem module to the system
board.

3. Disconnect the modem module cable (2) from the modem module.
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4. Lift up on the front of the modem module (3) to disconnect it from the system board.

5. Remove the modem module.

Reverse the above procedure to install the modem module, and be sure that the connector on the
bottom of the modem module connects firmly into the system board.
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Bluetooth module

Description Spare part number

Bluetooth module 537921-001

Bluetooth module cable 602822-001

Before removing the Bluetooth module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 43).

5. Remove the following components:

a. Hard drive (see Hard drive on page 44)

b. Optical drive (see Optical drive on page 47)

c. Keyboard (see Keyboard on page 53)

d. Top cover (see Top cover on page 55)

Remove the Bluetooth module:

1. Position the computer upright with the front toward you.

2. Disconnect the Bluetooth module cable (1) from the system board.

3. Remove the Bluetooth module and cable from the clips in the base enclosure (2).

4. Remove the Bluetooth module (3) from the base enclosure.

Reverse the above procedure to install the Bluetooth module.
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USB board

Description Spare part number

USB board (includes cable) 600631-001

Before removing the USB board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 43).

5. Remove the following components:

a. Hard drive (see Hard drive on page 44)

b. Optical drive (see Optical drive on page 47)

c. Keyboard (see Keyboard on page 53)

d. Top cover (see Top cover on page 55)

Remove the USB board:

1. Position the computer upright with the right side toward you.

2. Disconnect the USB board cable (1) from the system board.

3. Remove the Phillips PM2.5×3.0 screw (2) that secures the USB board to the base enclosure.

4. Lift the USB board (3) straight up to remove it from the computer.

Reverse this procedure to install the USB board.
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Power connector cable

Description Spare part number

Power connector cable (includes cable and connector) 600630-001

Before removing the power connector cable, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 43).

5. Remove the following components:

a. Hard drive (see Hard drive on page 44)

b. Optical drive (see Optical drive on page 47)

c. Keyboard (see Keyboard on page 53)

d. Top cover (see Top cover on page 55))

Remove the power connector cable:

1. Turn the computer upright with the right side toward you.

2. Disconnect the power connector cable (1) from the system board.

3. Lift the power connector (2) from the clips built into the base enclosure.

4. Remove the cable from the base enclosure.

Reverse this procedure to install the power connector cable.
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Display assembly

Description Spare part number

35.6 cm (14-in) WXGA Brightview display assembly for use with integrated microphone and
webcam; Presario, matte black

592146-001

35.6 cm (14-in) WXGA Brightview display assembly for use with integrated microphone and
webcam; Presario, biscotti

597617-001

35.6 cm (14-in) WXGA Brightview display assembly for use with integrated microphone and
webcam; HP, biscotti

600163-001

35.6 cm (14-in) WXGA Brightview display assembly for use with integrated microphone and
webcam; HP, silver

606155-001

35.6 cm (14-in) WXGA Brightview display assembly for use with integrated microphone and
webcam; HP, white (for model 1.0 only)

606156-001

35.6 cm (14-in) WXGA Brightview display assembly for use with integrated microphone and
webcam; HP, charcoal (for model 1.1 only)

622571-001

Before removing the display assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 43).

5. Disconnect the wireless antenna cables from the WLAN module (see WLAN module
on page 49).

6. Remove the following components:

a. Keyboard (see Keyboard on page 53)

b. Optical drive (see Optical drive on page 47)

c. Top cover (see Top cover on page 55)

Remove the display assembly:

1. Turn the computer display-side up, with the front toward you.

2. Open the display as far as possible.

3. Remove the wireless antenna cables (1) from the hole and clips built into the base enclosure.

4. Disconnect the display panel cable (2) from the system board.

5. Disconnect the microphone cable (3) from the system board.
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6. Disconnect the webcam cable (2) from the system board.

CAUTION: Support the display assembly when removing the display screws in the following
steps. Failure to support the display assembly can result in damage to the assembly and other
components.

7. Remove the four black Phillips PM2.5×6.5 screws (1) that secure the display assembly to the
computer.

8. Remove the display assembly (2).
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9. If it is necessary to replace any of the display assembly internal components, remove the
following screw covers and screws. The display screw covers are included in the display screw
kit, spare part number 592152-001.

(1) Two Mylar screw covers on the display bezel bottom edge

(2) Two Phillips PM2.5×4.0 screws

10. Flex the inside edge of the top (1), the left and right sides (2), and the bottom (3) of the display
bezel until the bezel disengages from the display back cover.

11. Remove the display bezel (4). The display bezel is available using spare part number
592147-001 for HP computers, and 592148-001 for Presario computers.
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12. If it is necessary to replace the webcam module, disconnect the webcam cable (1) from the
module. Lift the webcam from the double-sided tape on the display back cover, and remove the
webcam. 

13. If it is necessary to replace the display panel, remove the eight Phillips PM2.5×5.0 screws (1)
that secure the display panel to the display enclosure, and then lift the panel from the enclosure
(2). The display panel is available using the spare part number 592144-001.

14. If it is necessary to replace the display cable, follow these steps:

a. Turn the display panel upside down in front of you.

b. Peel back the tape that secures the cable to the display (1).

c. Unplug the cable from the display (2).

d. Remove the cable from the display (3).
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The display cable is available in the display cable kit, spare part number 592151-001.

15. If it is necessary to replace the display bracket and hinges, remove the Phillips PM2.0×3.0
screws (1) that secure each bracket to the display.

16. Remove the display hinges (2) from the display. The display bracket and hinge set is available
using spare part number 600627-001.

17. If it is necessary to replace the wireless antennas and cables, remove the adhesive strip (1) that
secures each antenna to the display back cover.

18. Detach the wireless antenna (2) from the display back cover .

19. Remove the antenna cables from the clips (3) built into the display enclosure.
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20. Remove the wireless antennas and cables (4) from the display enclosure. The wireless
antennas and cables are included in the display cable kit, spare part number 592151-001.

21. If it is necessary to remove the webcam cable, remove the cable from the adhesive strips (1)
along the cable path on the display back cover, and then remove the webcam cable (2). The
webcam cable is included in the display cable kit, spare part number 592151-001,
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22. If it is necessary to remove the microphone, release the microphone cable from the adhesive
strips (1) along the cable path on the display back cover, remove the microphone from the clips
on the display back cover (2), and then remove the microphone and microphone cable (3). The
microphone and cable is included in the display cable kit, spare part number 592151-001,

Reverse this procedure to reassemble and install the display assembly.
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System board

Description Spare part number

System board for use in models with UMA graphics subsystem memory, 592808-001

System board for use in models with DSC HD5430 MDM CR (for model 1.0 only) 592811-001

System board for use in models with DSC HD5430 (for model 1.0 only) 592810-001

System board for use in models with UMA graphics subsystem memory 592809-001

System board for use in models with HD545V DSC (for model 1.0 only) 611554-001

System board for use in models with HD545V DSC CR (for model 1.0 only) 611555-001

System board for use in models with discrete graphics subsystem with HD5470/512 MB (for
model 1.1 only)

616405–001

System board for use in models with discrete graphics subsystem with HD5470/512 MB with
HDMI card reader (for model 1.1 only)

616406–001

System board for use in models with discrete graphics subsystem with HD5470/1 G (for model 1.1
only)

616407–001

System board for use in models with discrete graphics subsystem with HD5470/1 G with HDMI
card reader (for model 1.1 only)

616408–001

When replacing the system board, be sure that the following components are removed from the
defective system board and installed on the replacement system board:

● RTC battery (see RTC battery on page 78)

● Memory modules (see Memory module on page 51)

● WLAN module (see WLAN module on page 49)

● Modem module (see Modem module on page 61)

Before removing the system board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 43).

5. Remove the following components:

a. Hard drive (see Hard drive on page 44)

b. WLAN (see WLAN module on page 49)

c. Optical drive (see Optical drive on page 47)

d. Keyboard (see Keyboard on page 53)

e. Top cover (see Top cover on page 55)
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f. Speaker assembly (see Speaker assembly on page 58)

g. Display assembly (see Display assembly on page 66)

h. Top cover (see Top cover on page 55)

Remove the following cables from the system board if still connected:

● Power connector cable (see Power connector cable on page 65)

● Bluetooth cable (see Bluetooth module on page 63)

● USB board cable (see USB board on page 64)

1. Turn the computer upright with the right side toward you.

2. Remove the three Phillips PM2.5×3.0 screws that secure the system board to the computer.

3. Release the optical drive cable (1) from the system board.

4. Lift the right side of the system board (2).
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5. Release the system board by sliding it to the right at an angle (3) until the connectors on the left
side of the system board clear the base enclosure, and then remove the system board.

6. If it is necessary to replace the modem module cable, remove the RJ-11 connector (1) from the
clip built into the base enclosure.

7. Remove the modem module cable (2) from the routing channel built into the base enclosure.
The modem module cable is available using spare part number 610791-001.

When replacing the system board, be sure that the following components are removed from the
defective system board and installed on the replacement system board:

● Fan/heat sink assembly (see Fan/heat sink assembly on page 80)

● Processor (see Processor on page 83)

Reverse the preceding procedure to install the system board.
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Optical drive SATA cable and connector

Description Spare part number

Optical drive cable (included in the cable kit) 610791-001

Before removing the optical drive cable, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 43).

5. Remove the following components:

a. Hard drive (see Hard drive on page 44)

b. WLAN (see WLAN module on page 49)

c. Optical drive (see Optical drive on page 47)

d. Keyboard (see Keyboard on page 53)

e. Top cover (see Top cover on page 55)

f. Speaker assembly (see Speaker assembly on page 58)

g. Display assembly (see Display assembly on page 66)

h. System board (see System board on page 73)

Remove the optical drive cable

1. Remove the two Phillips PM2.5×6.0 screws (1) that secure the optical drive connector to the
system board.
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2. Release the cable from the clips on the base enclosure (2), and then remove the cable (3).
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RTC battery

Description Spare part number

RTC battery 602745-001

Before removing the RTC battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 43).

5. Remove the following components:

a. Hard drive (see Hard drive on page 44)

b. WLAN (see WLAN module on page 49)

c. Optical drive (see Optical drive on page 47)

d. Keyboard (see Keyboard on page 53)

e. Top cover (see Top cover on page 55)

f. Speaker assembly (see Speaker assembly on page 58)

g. Display assembly (see Display assembly on page 66)

h. System board (see System board on page 73)

Remove the RTC battery:

1. Turn the system board upside down.

2. Release the RTC battery from the clips on the system board (1).
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3. Remove the RTC battery (2).

Reverse this procedure to install the RTC battery.
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Fan/heat sink assembly

Description Spare part number

Fan/heat sink assembly for use in models that use Universal Memory Architecture (UMA) graphics
subsystem memory (includes thermal material)

606609-001

Fan/heat sink assembly for use in models that use discrete graphics subsystem memory (includes
thermal material)

606610-001

Fan/heat sink assembly for use in models that use DSC HD545V graphics subsystem memory
(includes thermal material) (for model 1.0 only)

617029-001

NOTE: To properly ventilate the computer, allow at least a 7.6-cm (3-inch) clearance on the right
side and rear panel of the computer. The computer uses an electric fan for ventilation. The fan is
controlled by a temperature sensor and is designed to turn on automatically when high temperature
conditions exist. These conditions are affected by high external temperatures, system power
consumption, power management/battery conservation configurations, battery fast charging, and
software requirements. Exhaust air is displaced through the ventilation grill located on the left side of
the computer.

Before removing the fan/heat sink assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 43).

5. Remove the following components:

a. Hard drive (see Hard drive on page 44)

b. Optical drive (see Optical drive on page 47)

c. Keyboard (see Keyboard on page 53)

d. Top cover (see Top cover on page 55)

e. Speaker assembly (see Speaker assembly on page 58)

f. Display assembly (see Display assembly on page 66)

g. System board (see System board on page 73)

Remove the fan/heat assembly (fan/heat sink appearance may vary):

1. Turn the system board upside down.

2. Disconnect the fan cable (1) from the system board.

3. Follow the sequence embossed on heat sink to loosen the four Phillips PM2.5×7.0 captive
screws (2) that secure the fan/heat sink assembly to the system board.

80 Chapter 4   Removal and replacement procedures



NOTE: Due to the adhesive quality of the thermal material located between the fan/heat sink
assembly and system board components, it may be necessary to move the fan/heat sink
assembly from side to side to detach the assembly.

4. Remove the fan/heat sink assembly (3).

The thermal material must be thoroughly cleaned from the surface of the fan/heat sink assembly (1),
(3) and the processor (2) and video components (4) each time the fan/heat sink assembly is
removed. Thermal pads and thermal paste must be installed on all surfaces before the fan/heat sink
assembly is reinstalled.

NOTE: Thermal pads and thermal paste are included with all fan/heat sink assembly, system board,
and processor spare part kits.

The following illustration shows the locations for thermal material on systems with discrete graphics
subsystems.
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The thermal material must be thoroughly cleaned from the surface of the fan/heat sink assembly (1)
and (3), and the processor component (2), each time the fan/heat sink assembly is removed. Thermal
pads and thermal paste must be installed on all surfaces before the fan/heat sink assembly is
reinstalled.

The following illustration shows the locations for thermal material on systems with UMA graphics
subsystems.

Reverse this procedure to install the fan/heat sink assembly.
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Processor

NOTE: All processor spare part kits include thermal material.

Description Spare part number

Processor Advanced Micro Devices (AMD) DC P340 2.2GHz 25W DDR3-1066 Mhz 616343–001

Processor Advanced Micro Devices (AMD) DC N350 2.4GHz 35W DDR3-1066 Mhz 616334–001

Advanced Micro Devices (AMD) processor DC P540 2.4GHz 25W DDR3-1066 Mhz 616347–001

Advanced Micro Devices (AMD) processor DC N550 2.6GHz 35W DDR3-1066 Mhz 616337–001

Advanced Micro Devices (AMD) processor DC N640 2.9GHz 35W 616344–001

Advanced Micro Devices (AMD) processor P8640 1.9GHz 616335–001

Advanced Micro Devices (AMD) processor N850 2.2GHz 616345–001

Advanced Micro Devices (AMD) processor DC QC P940 1.7GHz 616336–001

Advanced Micro Devices (AMD) processor QC P950 2.1GHz 35W 616346–001

Processor Advanced Micro Devices (AMD) P320 DDR3-1066 Mhz 594165-001

Advanced Micro Devices (AMD) processor N120 DDR3-1066 Mhz 594171-001

Advanced Micro Devices (AMD) processor P520 DDR3-1066 Mhz 594173-001

Advanced Micro Devices (AMD) processor DC N330 2.3GHz 1M L2 35W 594164-001

Advanced Micro Devices (AMD) processor DC QC P920 1.6Ghz 2M L2 25W 594170-001

Advanced Micro Devices (AMD) processor DC N530 DC 2.5GHz L2 35W 594172-001

Advanced Micro Devices (AMD) processor DC P820 Tri-Core 1.8Ghz 1.5M L2 25W 594167-001

Advanced Micro Devices (AMD) processor N620 DDR3-1333 Mhz 594166-001

Advanced Micro Devices (AMD) processor DC N930 QC 2.0 GHz 594169-001

Advanced Micro Devices (AMD) processor DC N830 Tri-core 2.1Ghz 1.5M L2 35W 594168-001

Before removing the processor, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 43).

5. Remove the following components:

a. Hard drive (see Hard drive on page 44)

b. Optical drive (see Optical drive on page 47)

c. Keyboard (see Keyboard on page 53)
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d. Top cover (see Top cover on page 55)

e. Speaker assembly (see Speaker assembly on page 58)

f. Display assembly (see Display assembly on page 66)

g. System board (see System board on page 73)

h. Fan/heat sink assembly (see Fan/heat sink assembly on page 80)

Remove the processor:

1. Turn the processor locking screw (1) one-half turn counterclockwise until you hear a click.

2. Lift the processor (2) straight up and remove it.

NOTE: The gold triangle (3) on the processor must be aligned with the triangle icon (4)
embossed on the processor socket when you install the processor.

Reverse this procedure to install the processor.
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5 Setup Utility

Computer Setup in Windows 7
To view the drives installed on the computer, select Start > Computer.

On models with a secondary hard drive (drive D), the optical drive becomes drive E. The next drive
added to the system, such as a new USB drive, will be assigned the next available drive letter.

Starting Setup Utility

Setup Utility is a ROM-based information and customization utility that can be used even when your
Windows® operating system is not working.

The utility reports information about the computer and provides settings for startup, security, and
other preferences.

To start Setup Utility:

▲ Open Setup Utility by turning on or restarting the computer. While the “Press the ESC key for
Startup Menu” message is displayed in the lower-left corner of the screen, press f10.

– or –

1. Open Setup Utility by turning on or restarting the computer. While the “Press the ESC key for
Startup Menu” message is displayed in the lower-left corner of the screen, press esc.

2. When the Startup Menu is displayed, press f10.

Using Setup Utility

Changing the language of Setup Utility

The following procedure explains how to change the language of Setup Utility. If Setup Utility is not
already running, begin at step 1. If Setup Utility is already running, begin at step 2.

1. Open Setup Utility by turning on or restarting the computer. While the “Press the ESC key for
Startup Menu” message is displayed in the lower-left corner of the screen, press f10.

– or –

Open Setup Utility by turning on or restarting the computer. While the “Press the ESC key for
Startup Menu” message is displayed in the lower-left corner of the screen, press esc. When the
Startup Menu is displayed, press f10.

2. Use the arrow keys to select System Configuration > Language, and then press enter.
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3. Use the arrow keys to select a language, and then press enter.

4. When a confirmation prompt with your language selected is displayed, press enter.

5. To save your change and exit Setup Utility, use the arrow keys to select Exit > Exit Saving
Changes, and then press enter.

Your change goes into effect immediately.

Navigating and selecting in Setup Utility

Because Setup Utility is not Windows based, it does not support the TouchPad. Navigation and
selection are by keystroke.

● To choose a menu or a menu item, use the arrow keys.

● To choose an item in a list or to toggle a field, for example an Enable/Disable field, use either the
arrow keys or f5 or f6.

● To select an item, press enter.

● To close a text box or return to the menu display, press esc.

● To display additional navigation and selection information while Setup Utility is open, press f1.

Displaying system information

The following procedure explains how to display system information in Setup Utility. If Setup Utility is
not open, begin at step 1. If Setup Utility is open, begin at step 2.

1. Open Setup Utility by turning on or restarting the computer. While the “Press the ESC key for
Startup Menu” message is displayed in the lower-left corner of the screen, press f10.

– or –

Open Setup Utility by turning on or restarting the computer. While the “Press the ESC key for
Startup Menu” message is displayed in the lower-left corner of the screen, press esc. When the
Startup Menu is displayed, press f10.

2. Select the Main menu. System information such as the system time and date, and identification
information about the computer is displayed.

3. To exit Setup Utility without changing any settings, use the arrow keys to select Exit > Exit
Discarding Changes, and then press enter.

86 Chapter 5   Setup Utility



Restoring default settings in Setup Utility

The following procedure explains how to restore Setup Utility default settings. If Setup Utility is not
already running, begin at step 1. If Setup Utility is already running, begin at step 2.

1. Open Setup Utility by turning on or restarting the computer. While the “Press the ESC key for
Startup Menu” message is displayed in the lower-left corner of the screen, press f10.

– or –

Open Setup Utility by turning on or restarting the computer. While the “Press the ESC key for
Startup Menu” message is displayed in the lower-left corner of the screen, press esc. When the
Startup Menu is displayed, press f10.

2. Use the arrow keys to select Exit > Load Setup Defaults, and then press enter.

3. When the Setup Confirmation is displayed, press enter.

4. To save your change and exit Setup Utility, use the arrow keys to select Exit > Exit Saving
Changes, and then press enter.

Setup Utility default settings go into effect when the computer restarts.

NOTE: Your password, security, and language settings are not changed when you restore the
factory default settings.
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Exiting Setup Utility

You can exit Setup Utility with or without saving changes.

● To exit Setup Utility and save your changes from the current session:

If the Setup Utility menus are not visible, press esc to return to the menu display. Then use the
arrow keys to select Exit > Exit Saving Changes, and then press enter.

● To exit Setup Utility without saving your changes from the current session:

If the Setup Utility menus are not visible, press esc to return to the menu display. Then use the
arrow keys to select Exit > Exit Discarding Changes, and then press enter.

After either choice, the computer restarts in Windows.

Setup Utility menus

The menu tables in this section provide an overview of Setup Utility options.

NOTE: Some of the Setup Utility menu items listed in this chapter may not be supported by your
computer.

Main menu

Select To do this

System information ● View and change the system time and date.

● View identification information about the computer.

● View specification information about the processor, memory size,
system BIOS, and keyboard controller version (select models
only).

Security menu

Select To do this

Administrator password Enter, change, or delete an administrator password.

Power-On Password Enter, change, or delete a power-on password.
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System Configuration menu

Select To do this

Language Support Change the language of Setup Utility.

Button Sound (select models only) Enable/disable the capacitive button tapping sound.

Virtualization Technology (select models only) Enable/disable the processor Virtualization Technology.

Processor C6 State (select models only) Enable/disable the processor C6 sleep state.

LAN Power Saving (select models only) Enable/disable LAN Power Saving. When enabled, saves power when
the computer is in DC mode.

Card Reader/1394 Power Saving (select models
only)

Enable/disable Card Reader/1394 Power Saving.

Fan Always On Enabled/disable Fan Always On. When enabled, the computer fan will
always be on.

Action Keys Mode Enable/disable Action Keys Mode.

Boot Options Set the following boot options:

● POST hotkey delay (sec.)―Set the delay for the f1, f2, f9, f10, f11,
and f12 functions of Setup Utility in intervals of 5 seconds each (0,
5, 10, 15, 20).

● CD-ROM Boot―Enable/disable boot from CD-ROM.

● Floppy Boot―Enable/disable boot from diskette.

● Internal Network Adapter Boot―Enable/disable boot from the
internal network adapter.

● Boot Order―Set the boot order for:

◦ Notebook Hard Drive

◦ Internal CD/DVD ROM Drive

◦ USB Diskette on Key/USB Hard Disk

◦ USB CD/DVD ROM Drive

◦ USB Floppy

◦ Network Adapter

Diagnostics menu

Select To do this

Hard Disk Self Test Run a comprehensive self-test on the hard drive.

NOTE: On models with two hard drives, this menu option is called the
Primary Hard Disk Self Test.

Secondary Hard Disk Self Test (select models
only)

Run a comprehensive self-test on a secondary hard drive.

Memory Test Run a diagnostic test on the system memory.
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Computer Setup in Linux

Starting Computer Setup

Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating
system is not working or will not load.

NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer.

NOTE: Pointing devices are not supported in Computer Setup. You must use the keyboard to
navigate and make selections.

NOTE: An external keyboard connected by USB can be used with Computer Setup only if USB
legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer.

2. Before your operating system opens and while the “F10=ROM Based Setup” message is
displayed in the lower-left corner of the screen, press f10.

Using Computer Setup

Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed from the File, Security, Diagnostics,
and System Configuration menus.

1. Open Computer Setup by turning on or restarting the computer, and then pressing f10 while the
"F10 = ROM Based Setup" message is displayed in the lower-left corner of the screen.

Because Computer Setup is not operating system based, it does not support the TouchPad.
Navigation and selection are by keystroke:

● To choose a menu or a menu item, use the arrow keys.

● To select an item, press enter.

● To close open dialog boxes and return to the main Computer Setup screen, press esc.

● To view navigation information, press f1.

● To change the language, press f2.

2. Select the File, Security, Diagnostics, or System Configuration menu.

3. To exit Computer Setup, choose one of the following methods:

● To exit Computer Setup without saving your preferences, use the arrow keys to select File
> Ignore Changes And Exit. Then follow the instructions on the screen.

● To save your preferences and exit Computer Setup, use the arrow keys to select File >
Save Changes And Exit. Then follow the instructions on the screen.

Your preferences go into effect when the computer restarts.
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Restoring factory settings in Computer Setup

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Open Computer Setup by turning on or restarting the computer, and then pressing f10 while the
"F10 = ROM Based Setup" message is displayed in the lower-left corner of the screen.

2. Use the arrow keys to select File > Restore Defaults, and then press enter.

3. When the confirmation dialog box opens, press f10.

4. To save your preferences and exit Computer Setup, use the arrow keys to select File > Save
Changes And Exit. Then follow the instructions on the screen.

Your preferences go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the factory
settings.
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Computer Setup menus

The menu tables in this section provide an overview of Computer Setup options.

NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by
your computer.

File menu

Select To do this

System information ● View identification information for the computer.

● View specification information for the processor, cache
and memory size, and system ROM.

Restore Defaults Replace the configuration settings in Computer Setup with
the original factory settings. (Password settings and security
settings are not changed when you restore the factory
settings.)

Ignore Changes And Exit Cancel any changes entered during the current session.
Then exit and restart the computer.

Save Changes And Exit Save any changes entered during the current session. Then
exit and restart the computer. Your changes go into effect
when the computer restarts.
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Security menu

NOTE: Some of the menu items listed in this section may not be supported by your computer.

Select To do this

Setup Password Enter, change, or delete a setup password.

Power-On Password Enter, change, or delete a power-on password.

Password Options ● Enable/disable stringent security.

● Enable/disable the password requirement on computer
restart.

DriveLock Passwords ● Enable/disable DriveLock on any computer hard drive.

● Enter, change, or disable DriveLock on an optional
MultiBay hard drive.

NOTE: DriveLock settings are accessible only when you
enter Computer Setup by turning on (not restarting) the
computer.

System IDs Enter a user-defined computer asset tracking number and
ownership tag.

Disk Sanitizer Run Disk Sanitizer to destroy all existing data on the primary
hard drive. The following options are available:

● Fast: Runs the Disk Sanitizer erase cycle once.

● Optimum: Runs the Disk Sanitizer erase cycle 3 times.

● Custom: Allows you to select the desired number of
Disk Sanitizer erase cycles from a list.

CAUTION: If you run Disk Sanitizer, the data on the
primary hard drive is destroyed permanently.

Diagnostics menu

Select To do this

HDD Self-Test Options Run a comprehensive self-test on any hard drive in the
system or on any optional MultiBay hard drive.

Memory Check Run a comprehensive check on system memory.
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System Configuration menu

NOTE: Some of the listed System Configuration options may not be supported by your computer.

Select To do this

Language Change the Computer Setup language.

Boot options ● Set an f9, f10, and f12 delay when starting up.

● Enable/disable CD-ROM boot.

● Enable/disable floppy boot.

● Enable/disable internal network adapter boot.

● Enable/disable MultiBoot, which sets a boot order that
can include most boot devices in the system.

● Set the Express Boot Popup delay in seconds.

● Set the boot order.

◦ 1st boot device: USB CD-ROM

◦ 2nd boot device: USB floppy

◦ 3rd boot device: USB SuperDisk

◦ 4th boot device: Notebook hard drive

◦ 5th boot device: USB hard disk

◦ 6th boot device: Network controller

Device Configurations ● Swap the functions of the fn key and left ctrl key.

● Enable/disable USB legacy support. When enabled,
USB legacy support allows the following:

◦ Use of a USB keyboard in Computer Setup even
when a your operating system is not running.

◦ Startup from bootable USB devices, including a
hard drive, diskette drive, or optical drive
connected by a USB port to the computer.

● Enable/disable BIOS DMA data transfers.

● Enable/disable fan always on while connected to an AC
outlet.

● Enable/disable data execution prevention.

● Enable/disable LAN power saving mode.

● Enable/disable SATA Native Mode.

● Enable/disable Dual Core CPU.

● Enable/disable HDD translation mode.
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Select To do this

Built-in device options ● Enable/disable embedded WLAN Device Radio.

● Enable/disable embedded Bluetooth Device Radio.

● Enable/disable Network Interface Controller (NIC)

● Enable/disable LAN/WLAN Switching.

● Enable/disable Wake on LAN.

● Enable/disable the integrated camera (webcam)

Port options ● Enable/disable USB port.

● Enable/disable ExpressCard slot.
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6 Specifications

Computer specifications

Dimensions

Depth 22.8 cm (8.98 in)

Width 34.2 cm (13.46 in)

Height (front to rear) 31.5 to 36.5 cm (1.24 to 1.44 in)

Weight (lowest weight configuration) < 2.20 kg (4.85 lbs)

Input power

Operating voltage 18.5 V dc @ 4.74 A – 90 W

Operating current 4.74 A

Temperature

Operating (not writing to optical disc) 0°C to 35°C (32°F to 95°F)

Operating (writing to optical disc) 5°C to 35°C (41°F to 95°F)

Nonoperating -20°C to 60°C (-4°F to 140°F)

Relative humidity

Operating 10% to 90%

Nonoperating 5% to 95%

Maximum altitude (unpressurized)

Operating -15 m to 3,048 m (-50 ft to 10,000 ft)

Nonoperating -15 m to 12,192 m (-50 ft to 40,000 ft)

NOTE: Applicable product safety standards specify thermal limits for
plastic surfaces. The computer operates well within this range of
temperatures.
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35.6-cm (14.0-in) display specifications

Dimensions

Height 17.6 cm (17.6 cm)

Width 31.1 cm (12.24 in)

Diagonal 35.7 cm (14.06 in)

Number of colors Up to 16.8 million

Contrast ratio 300:1 (typical)

Brightness 200 nits (typical)

Pixel resolution

Pitch 0.259 × 0.259 mm

Format 1280 × 800; HD: 1366 × 768

Configuration RGB vertical stripe

Backlight LED

Character display 80 × 25

Total power consumption 4.0 W

Viewing angle ±40° horizontal, +120/-40° vertical (typical)
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Hard drive specifications

 500-GB* 320-GB* 250-GB* 160-GB*

Dimensions

Height 9.5 mm 9.5 mm 9.5 mm 9.5 mm

Width 70 mm 70 mm 70 mm 70 mm

Weight 101 g 101 g 101 g 101 g

Interface type SATA SATA SATA SATA

Transfer rate 100 MB/sec 100 MB/sec 100 MB/sec 100 MB/sec

Security ATA security ATA security ATA security ATA security

Seek times (typical read, including setting)

Single track 1.0 ms 1.5 ms 2.0 ms 1.5 ms

Average 14.0 ms 12.0 ms 12.0 ms 11.0 ms

Maximum 22.0 ms 22.0 ms 22.0 ms 22.0 ms

Logical blocks 976,773,168 625,142,448 488,397,168 312,581,808

Disc rotational speed 7200 rpm 7200 rpm 7200 rpm 7200 rpm

Operating temperature 5°C to 55°C (41°F to 131°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive
specifications may differ slightly.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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DVD±RW SuperMulti Double-Layer Drive with LightScribe
specifications

Applicable disc  

Read CD-DA, CD+(E)G, CD-MIDI, CD-TEXT, CD-ROM, CD-ROM XA, MIXED
MODE CD, CD-I, CD-I Bridge (Photo-CD, Video CD), Multisession CD
(Photo-CD, CD-EXTRA, Portfolio, CD-R, CD-RW), CD-R, CD-RW, DVD-
ROM (DVD-5, DVD-9, DVD-10, DVD-18), DVD-R, DVD-RW, DVD+R, DVD
+RW, DVD-RAM

Write CD-R and CD-RW, DVD+R, DVD+RW, DVD-R, DVD-RW, DVD-RAM

Random access time  

DVD < 230 ms

CD < 175 ms

Cache buffer 2 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec

8X DVD-ROM 10,800 KB/sec

24X CD-R 3,600 KB/sec

16X CD-RW 2,400 KB/sec

8X DVD+R 10,800 KB/sec

4X DVD+RW 5,400 KB/sec

8X DVD-R 10,800 KB/sec

4X DVD-RW 5,400 KB/sec

2.4X DVD+R(9) 2,700 KB/sec

5X DVD-RAM 6,750 KB/sec

Transfer mode Multiword DMA Mode
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Blu-ray ROM with LightScribe DVD±R/RW SuperMulti DL
Drive specifications

Applicable disc  

Read BD-ROM, BD-ROM-DL, BD-R, BD-R-DL, BD-RE, BD-RE-DL, DVD-ROM,
DVD+R, DVD+R-DL, DVD+RW, DVD-R, DVD-R-DL, DVD-RW, DVD-RAM
(Ver.2), CD-DA, CD-ROM (mode 1 and mode 2), CD-ROM XA (mode 2,
form 1 and form 2), Photo CD (single and multiple sessions), CD Extra,
CD-R, CD-RW, and CD-TEXT

Write DVD-RAM (Ver.2), DVD+R, DVD-R, CD-R, and CD-ROM

Random access time  

BD < 230 ms

DVD < 180 ms

CD < 180 ms

Cache buffer 8 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec

8X DVD-ROM 10,800 KB/sec

4X BD 18,000 KB/sec

24X CD-R 3,600 KB/sec

16X CD-RW 2,400 KB/sec

8X DVD+R 10,800 KB/sec

4X DVD+RW 5,400 KB/sec

8X DVD-R 10,800 KB/sec

4X DVD-RW 5,400 KB/sec

2.4X DVD+R(9) 2,700 KB/sec

5X DVD-RAM 6,750 KB/sec

1X BD-ROM 4,500 KB/sec

1X BD-R read 4,500 KB/sec

1X BD-RE read 4,500 KB/sec

Transfer mode Multiword DMA Mode
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System resource specifications
You can use Device Manager to get a graphical view of the system resources that control how the
devices work on the computer. System resources you can access from Device Manager are direct
memory access (DMA) channels, input/output (I/O) ports, interrupt request (IRQ) lines, and memory
addresses.

If two devices require the same resource and create a device conflict, you can manually change the
resource settings in Device Manager to be sure each setting is unique.

CAUTION: Improperly changing resource settings can disable your hardware and cause your
computer to malfunction or become inoperable. Only users who have expert knowledge of computer
hardware and hardware configurations should change resource settings.

To view resource settings in Windows 7 and Windows Vista:

1. Select Start > Computer.

2. Click System properties near the top of the Computer folder.

3. On the left, click Device Manager.

4. On the View menu, click one of the following:

● Resources by type

● Resources by connection

To view resource settings in Windows XP:

1. Select Start > My Computer, or double-click My Computer on the desktop.

2. Under System Tasks, click View system information.

3. In the System Properties window, select the Hardware tab.

4. Click Device Manager.

5. On the View menu, click one of the following:

● Resources by type

● Resources by connection
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7 Backup and recovery

Recovery after a system failure is as complete as your most current backup. HP recommends that
you create recovery discs immediately after software setup. As you add new software and data files,
you should continue to back up your system on a regular basis to maintain a reasonably current
backup.

Tools provided by the operating system and HP Recovery Manager software are designed to help
you with the following tasks for safeguarding your information and restoring it in case of a system
failure:

● Creating a set of recovery discs (Recovery Manager software feature). Recovery discs are used
to start up (boot) your computer and restore the operating system and software programs to
factory settings in case of system failure or instability.

● Backing up your information regularly to protect your important system files.

● Creating system restore points (operating system feature). System restore points allow you to
reverse undesirable changes to your computer by restoring the computer to an earlier state.

● Recovering a program or driver (Recovery Manager software feature). This feature helps you
reinstall a program or driver without performing a full system recovery.

● Performing a full system recovery (Recovery Manager software feature). With Recovery
Manager, you can recover your full factory image if you experience system failure or instability.
Recovery Manager works from a dedicated recovery partition (select models only) on the hard
drive or from recovery discs you create.

NOTE: Computers with a solid-state drive (SSD) may not have a recovery partition. Recovery
discs have been included for computers that do not have a partition. Use these discs to recover
your operating system and software. To check for the presence of a recovery partition, select
Start, right-click Computer, click Manage, and then click Disk Management. If the partition is
present, an HP Recovery drive is listed in the window.

Windows 7
To protect your information, back up your files and folders. In case of system failure, you can use the
backup files to restore your computer.

CAUTION: In the event of a hard drive failure, you cannot use your computer to access the Disaster
Recovery utility. Therefore, HP recommends that you download the Disaster Recovery utility SoftPaq,
and then extract it to a USB flash drive as soon as possible after software setup. For details, refer to
“Downloading and extracting the Disaster Recovery utility” later in this section.
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Depending on your computer model, you may have one of the following backup and recovery
solutions:

● Roxio BackOnTrack

● HP Recovery Manager

NOTE: For detailed information, perform a search for these topics in Help and Support.

Creating recovery discs

HP recommends that you create recovery discs to be sure that you can restore your system to its
original factory state if you experience serious system failure or instability. Create these discs after
setting up the computer for the first time.

Handle these discs carefully and keep them in a safe place. The software allows the creation of only
one set of recovery discs.

NOTE: You can use an optional external optical drive (purchased separately) to create recovery
discs, or you can purchase recovery discs for your computer from the HP Web site.

Note the following guidelines before creating recovery discs:

NOTE: The external hard drive must be connected to a USB port on the computer, not to a USB
port on an external device such as a hub.

● You will need high-quality DVD-R, DVD+R, BD-R (writable Blu-ray), or CD-R discs. All these
discs are purchased separately. DVDs and BDs have a much higher capacity than CDs. If you
use CDs, up to 20 discs may be required, whereas only a few DVDs or BDs are required.

NOTE: Read-write discs, such as CD-RW, DVD±RW, double-layer DVD±RW, and BD-RE
(rewritable Blu-ray) discs, are not compatible with the Recovery Manager software.

● The computer must be connected to AC power during this process.

● Only one set of recovery discs can be created per computer.

● Number each disc before inserting it into the optical drive.

● If necessary, you can exit the program before you have finished creating the recovery discs. The
next time you open Recovery Manager, you will be prompted to continue the disc creation
process.

To create a set of recovery discs:

1. Select Start > All Programs > Recovery Manager > Recovery Disk Creation.

2. Follow the on-screen instructions.
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Backing up your information

As you add new software and data files, you should back up your system on a regular basis to
maintain a reasonably current backup. Back up your system at the following times:

● At regularly scheduled times

NOTE: Set reminders to back up your information periodically.

● Before the computer is repaired or restored

● Before you add or modify hardware or software

Note the following when backing up:

● Create system restore points using the Windows® System Restore feature, and periodically
copy them to disc.

● Store personal files in the Documents library and back up this folder periodically.

● Back up templates stored in their associated programs.

● Save customized settings in a window, toolbar, or menu bar by taking a screen shot of your
settings. The screen shot can be a time-saver if you have to reset your preferences.

To copy the screen and paste it into a word-processing document, follow these steps:

1. Display the screen.

2. Copy the screen:

To copy only the active window, press alt+prt sc.

To copy the entire screen, press prt sc.

3. Open a word-processing document, and then select Edit > Paste.

4. Save the document.

● You can back up your information to an optional external hard drive, a network drive, or discs.

● When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD-R, or DVD±RW. The discs you use will depend on the type of optical
drive installed in your computer.

NOTE: DVDs store more information than CDs, so using them for backup reduces the number
of recovery discs required.

● When backing up to discs, number each disc before inserting it into the optical drive of the
computer.
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Using Windows Backup and Restore

To create a backup using Windows Backup and Restore, follow these steps:

NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to set up and create a backup.

NOTE: Windows® includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.
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Using system restore points

When you back up your system, you are creating a system restore point. A system restore point
allows you to save and name a snapshot of your hard drive at a specific point in time. You can then
recover back to that point if you want to reverse subsequent changes made to your system.

NOTE: Recovering to an earlier restore point does not affect data files saved or e-mails created
since the last restore point.

You also can create additional restore points to provide increased protection for your system files and
settings.

When to create restore points

● Before you add or extensively modify software or hardware

● Periodically, whenever the system is performing optimally

NOTE: If you revert to a restore point and then change your mind, you can reverse the restoration.

Create a system restore point

1. Select Start > Control Panel > System and Security > System.

2. In the left pane, click System Protection.

3. Click the System Protection tab.

4. Under Protection Settings, select the disk for which you want to create a restore point.

5. Click Create.

6. Follow the on-screen instructions.

Restore to a previous date and time

To revert to a restore point (created at a previous date and time), when the computer was functioning
optimally, follow these steps:

1. Select Start > Control Panel > System and Security > System.

2. In the left pane, click System protection.

3. Click the System Protection tab.

4. Click System Restore.

5. Follow the on-screen instructions.

Performing a recovery

NOTE: You can recover only files that you have previously backed up. HP recommends that you
use HP Recovery Manager to create a set of recovery discs (entire drive backup) as soon as you set
up your computer.

Recovery Manager software allows you to repair or restore the system if you experience system
failure or instability. Recovery Manager works from recovery discs or from a dedicated recovery
partition (select models only) on the hard drive. However, if your computer includes a solid-state drive
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(SSD), you may not have a recovery partition. If that is the case, recovery discs have been included
with your computer. Use these discs to recover your operating system and software.

NOTE: Windows has its own built-in repair features, such as System Restore. If you have not
already tried these features, try them before using Recovery Manager.

NOTE: Recovery Manager recovers only software that was preinstalled at the factory. Software not
provided with this computer must be downloaded from the manufacturer's Web site or reinstalled from
the disc provided by the manufacturer.

Recovering from the recovery discs

To restore the system from the recovery discs:

1. Back up all personal files.

2. Insert the first recovery disc into the optical drive and restart the computer.

3. Follow the on-screen instructions.

Recovering from the dedicated recovery partition (select models only)

NOTE: Computers with an SSD may not have a recovery partition. If the computer does not have a
recovery partition, you will not be able to recover using this procedure. Recovery discs have been
included for computers that do not have a partition. Use these discs to recover your operating system
and software.

On some models, you can perform a recovery from the partition on the hard drive, accessed by
pressing either the Start button or f11. This restores the computer to its factory condition.

To restore the system from the partition, follow these steps:

1. Access Recovery Manager in either of the following ways:

● Select Start > All Programs > Recovery Manager > Recovery Manager.

– or –

● Turn on or restart the computer, and then press esc while the “Press the ESC key for
Startup Menu” message is displayed at the bottom of the screen. Then, press f11 while the
“Press <F11> for recovery” message is displayed on the screen.

2. Click System Recovery in the Recovery Manager window.

3. Follow the on-screen instructions.
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Linux backup and recovery
Use the instructions in this section if SUSE Linux SLED 11 is installed on your computer.

To protect your information, back up your files and folders. Then if the system fails, you can restore
your important files from copies. You can also use the options listed in this section to restore the
operating system and programs that were installed at the factory.

CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
you have created and any software installed on the computer are permanently removed. The f11
recovery tool reinstalls the original operating system and HP programs and drivers that were installed
at the factory. Software, drivers, and updates not installed by HP must be manually reinstalled.
Personal files must be restored from a backup.

To recover the original hard drive image using f11, follow these steps:

1. If possible, back up all personal files.

2. Restart the computer, and then press f11 while the “Press <F11> for recovery” message is
displayed on the screen.

3. Follow the on-screen instructions.

NOTE: If you are unable to boot (start up) your computer from the primary operating system or from
the recovery f11 method, you must purchase a SUSE Linux Enterprise Desktop Operating System
DVD to repair the operating system. For additional information, refer to the Worldwide Telephone
Numbers booklet, included with the computer.
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8 Connector pin assignments

Audio-out (headphone)

Pin Signal

1 Audio out, left channel

2 Audio out, right channel

3 Ground

Audio-in (microphone)

Pin Signal

1 Audio signal in

2 Audio signal in

3 Ground
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External monitor

Pin Signal

1 Red analog

2 Green analog

3 Blue analog

4 Not connected

5 Ground

6 Ground analog

7 Ground analog

8 Ground analog

9 +5 VDC

10 Ground

11 Monitor detect

12 DDC 2B data

13 Horizontal sync

14 Vertical sync

15 DDC 2B clock
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RJ-11 (modem)

Pin Signal

1 Unused

2 Tip

3 Ring

4 Unused

5 Unused

6 Unused

RJ-45 (network)

Pin Signal

1 Transmit +

2 Transmit -

3 Receive +

4 Unused

5 Unused

6 Receive -

7 Unused

8 Unused
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HDMI

Pin Signal

1 TMDS data 2+

2 TMDS data 2 shield

3 TMDS data 2–

4 TMDS data 1+

5 TMDS data 1shield

6 TMDS data 1–

7 TMDS data 0+

8 TMDS data 0 shield

9 TMDS data 0–

10 TMDS clock+

11 TMDS clock shield

12 TMDS clock–

13 CEC

14 No connect

15 DDC clock

16 DDC data

17 Ground

18 +5V power

19 Hot plug detect

20 Shell
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Universal Serial Bus

Pin Signal

1 +5 VDC

2 Data -

3 Data +

4 Ground
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9 Power cord set requirements

The wide range input feature of the computer permits it to operate from any line voltage from 100 to
120 volts AC or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.

Power cord sets for use in other countries or regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries or regions
The requirements listed below are applicable to all countries or regions:

● The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

● All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region where the power cord set will be used.

● The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by each country or region’s power system.

● The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries or regions

Country/region Accredited agency Applicable note number

Australia EANSW 1

Austria OVE 1

Belgium CEBC 1

Canada CSA 2

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

Italy IMQ 1

Japan METI 3

The Netherlands KEMA 1

Norway NEMKO 1

The People's Republic of China CCC 5

South Korea EK 4

Sweden SEMKO 1

Switzerland SEV 1

Taiwan BSMI 4

The United Kingdom BSI 1

The United States UL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance
coupler and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region
where it will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall
plug must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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10 Recycling

Battery
When a battery has reached the end of its useful life, do not dispose of the battery in general
household waste. Follow the local laws and regulations in your area for computer battery disposal.

Display
WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

CAUTION: The procedures in this chapter can result in damage to display components. The only
components intended for recycling purposes are the liquid crystal display (LCD) panel and the
backlight. When you remove these components, handle them carefully.

NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display
assembly that might require special handling at end-of-life. Disposal of mercury may be regulated
because of environmental considerations. For disposal or recycling information, contact your local
authorities, or see the Electronic Industries Alliance (EIA) Web site at http://www.eiae.org.

This section provides disassembly instructions for the display assembly. The display assembly must
be disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

NOTE: The procedures provided in this chapter are general disassembly instructions. Specific
details, such as screw sizes, quantities, and locations, and component shapes and sizes, can vary
from one computer model to another.
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Perform the following steps to disassemble the display assembly:

1. Remove all screw covers (1) and screws (2) that secure the display bezel to the display
assembly.

2. Lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of
the display bezel until the bezel disengages from the display assembly.

3. Remove the display bezel (3).
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4. Disconnect all display panel cables (1) from the display inverter and remove the inverter (2).

5. Remove all screws (1) that secure the display panel assembly to the display enclosure.

6. Remove the display panel assembly (2) from the display enclosure.

7. Turn the display panel assembly upside-down.

8. Remove all screws that secure the display panel frame to the display panel.

9. Use a sharp-edged tool to cut the tape (1) that secures the sides of the display panel to the
display panel frame.
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10. Remove the display panel frame (2) from the display panel.

11. Remove the screws (1) that secure the backlight cover to the display panel.

12. Lift the top edge of the backlight cover (2) and swing it outward.

13. Remove the backlight cover.

14. Turn the display panel right-side up.
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15. Remove the backlight cables (1) from the clip (2) in the display panel.

16. Turn the display panel upside-down.

WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

17. Remove the backlight frame from the display panel.
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18. Remove the backlight from the backlight frame.

19. Disconnect the display panel cable (1) from the LCD panel.

20. Remove the screws (2) that secure the LCD panel to the display rear panel.

21. Release the LCD panel (3) from the display rear panel.

22. Release the tape (4) that secures the LCD panel to the display rear panel.

23. Remove the LCD panel.

24. Recycle the LCD panel and backlight.
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Index

Symbols/Numerics
1394 Power Saving 89

A
AC adapter

identifying 18
AC adapter, spare part

numbers 30
administrator password 88
antenna

removal 70
antennas 17
applications key, Windows 12
audio, product description 4
audio-in jack, pin

assignments 109
audio-out jack, pin

assignments 109

B
backing up

customized window, toolbar,
and menu bar settings 104

personal files 104
templates 104

base enclosure, spare part
number 24

battery
removal 43
spare part numbers 24, 43

battery bay, identifying 16
battery release latch,

identifying 16
battery, identifying 18
bays

battery 16
hard drive 16

BD/DVD±R/RW Super Multi
Double-Layer Combo Drive

removal 47

bezel
illustrated 26
spare part number 26, 68

Blu-ray Disc ROM LightScribe with
SuperMulti DVD±R/RW Double-
Layer

spare part number 25, 29, 47
Blu-ray ROM with LightScribe DVD

±R/RW SuperMulti DL Drive
specifications 100

Bluetooth module
removal 63
spare part number 24, 63

boot options 89, 94
boot order 89, 94
button sound 89
buttons

power 11
TouchPad right/left 9

C
cable kit, spare part number 25
cables, service considerations 37
camera module

removal 69
spare part number 69

camera, product description 4
caps lock light, identifying 10
Card Reader Power Saving 89
changing the language of Setup

Utility 85
chipset, product description 2
compartments

memory module 16
components

additional hardware 18
bottom 16
front 8
left-side 15

right-side 14
top 9

computer feet
locations 42
spare part number 42

Computer Setup
accessing 90
Diagnostics menu 93
File menu 92
navigating and selecting 90
restoring factory settings 91
Security menu 93
System Configuration

menu 94
using 90

computer specifications 96
connector pin assignments

audio-in 109
audio-out 109
external monitor 110
HDMI 112
headphone 109
microphone 109
modem 111
monitor 110
network 111
RJ-11 111
RJ-45 111
Universal Serial Bus

(USB) 113
connector, power 14
connectors, service

considerations 37
cord, power 18

D
Diagnostics menu 89, 93
Digital Media Slot light,

identifying 15
Digital Media Slot, identifying 15
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diskette drive
precautions 37
product description 4

display assembly
removal 66
spare part number 20, 66

display back cover
spare part number 27

display bezel
illustrated 26
spare part number 26, 68

display bracket and hinge
removal 70
spare part number 70

display cable kit
spare part number 26

display component recycling 116
display components

illustrated 26
spare part numbers 26

display enclosure
illustrated 26

display hinge kit, spare part
number 26

display inverter
illustrated 26

display panel
illustrated 26
product description 3
removal 69
spare part number 26, 69

Display screw kit, spare part
number 27

display specifications 97
displaying system information 86
drives

boot order 89, 94
preventing damage 37

DVD/CD-RW Combo Drive
precautions 37
removal 47

DVD±RW and CD-RW Combo
Drive

precautions 37
removal 47

DVD±RW SuperMulti DL Drive
with LightScribe

spare part numbers 25, 29, 47

DVD±RW SuperMulti Double-
Layer Drive with LightScribe

specifications 99

E
electrostatic discharge 38
esc key, identifying 12
Ethernet, product description 5
exiting Setup Utility 88
external media cards, product

description 5
external monitor port

pin assignments 110
external monitor port,

identifying 15

F
f11 107
fan always on 89
fan/heat sink assembly

removal 80
spare part number 21, 80

feet
locations 42
spare part number 42

File menu 92
fn key, identifying 12
front components 8
full system recovery 102
function keys, identifying 12

G
graphics, product description 2
grounding equipment and

methods 40

H
hard drive

precautions 37
product description 4
removal 44
spare part numbers 25, 29, 44
specifications 98

hard drive bay, identifying 16
hard drive cover

illustrated 28
removal 45

hard drive hardware kit, spare part
number 29

hard drive self test 89
HDMI 15

HDMI port, pin assignments 112
headphone jack, pin

assignments 109

I
inverter

illustrated 26

J
jacks

RJ-11 (modem) 14
RJ-45 (network 15

K
keyboard

product description 6
removal 53
spare part numbers 21, 53

keys
esc 12
fn 12
function 12
navigation 12
Windows applications 12
Windows logo 12

L
LAN Power Saving 89
language support 89
latch, battery release 16
legacy support, USB 90, 94
light

power 10
lights

caps lock 10
Digital Media Slot 15
optical drive 14
webcam 13
wireless 10

M
Main menu 88
mass storage devices, spare part

numbers 29
memory module

product description 3
removal 51
spare part numbers 22, 51

memory module compartment,
identifying 16

memory test 89
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microphone (internal),
identifying 13

microphone jack, pin
assignments 109

microphone, product
description 4

mini-card compartment cover
illustrated 28
removal 52
spare part number 52

model name 1
modem cable

noise suppression circuitry 18
modem jack, pin

assignments 111
modem module

product description 5
removal 61
spare part number 22, 61

modem module cable
removal 75

monitor port, external 15
monitor port, pin

assignments 110

N
navigating in Setup Utility 86
navigation keys, identifying 12
network jack, pin

assignments 111
noise suppression circuitry

modem cable 18

O
ODD cable

removal 76
spare part number 76

operating system, product
description 6

optical drive
identifying 14
precautions 37
product description 4
removal 47
spare part numbers 25, 29, 47
specifications 99, 100

optical drive light, identifying 14

P
packing guidelines 39
passwords 88, 93

performing a recovery 106
plastic parts 36
Plastics kit

contents 28
spare part number 28

plastics kit
spare part number 22

pointing device, product
description 6

ports
external monitor 15
HDMI 15
product description 5
USB 14, 15

power button board
removal 59
spare part number 59

power button, identifying 11
power connector cable

removal 65
spare part number 24, 65

power connector, identifying 14
power cord set requirements 114
power cord, identifying 18
power cord, spare part

numbers 30
power light, identifying 10
power requirements, product

description 6
power-on password 88
processor

product description 1
removal 83
spare part numbers 23, 83

Processor C6 State 89
product description

audio 4
camera 4
chipset 2
diskette drive 4
display panel 3
Ethernet 5
external media cards 5
graphics 2
hard drives 4
keyboard 6
memory module 3
microphone 4
modem module 5
operating system 6

optical drives 4
pointing devices 6
ports 5
power requirements 6
processors 1
product name 1
security 6
serviceability 6
wireless 5

product name 1

R
recovering a program or

driver 102
recovering from the dedicated

recovery partition 107
recovering from the recovery

discs 107
recovery discs 102, 103
Recovery Manager 102, 107
recovery partition 102
recovery, system 107
removal/replacement

preliminaries 36
procedures 41

restore points 106
restoring default settings 87
RJ-11 (modem) jack,

identifying 14
RJ-11 jack, pin assignments 111
RJ-45 (network) jack,

identifying 15
RJ-45 jack, pin assignments 111
RTC battery

removal 78
spare part number 22, 78

Rubber Feet Kit, spare part
number 42

S
secondary hard drive self test 89
security cable slot, identifying 14
Security menu 88, 93
security, product description 6
selecting in Setup Utility 86
serial number 19, 41
service considerations 36
serviceability, product

description 6

124 Index



setup utility
Diagnostics menu 93
File menu 92
navigating and selecting 90
restoring factory settings 91
Security menu 93
System Configuration

menu 94
slots

Digital Media 15
memory module 16
security cable 14

solid-state drive (SSD) 102, 107
speaker assembly

removal 58
spare part number 21, 58

speakers, identifying 11
specifications

Blu-ray ROM with LightScribe
DVD±R/RW SuperMulti DL
Drive 100

computer 96
display 97
DVD ±RW SuperMulti Double-

Layer Drive with
LightScribe 99

hard drive 98
optical drive 99, 100
system resources 101

starting Setup Utility 85
static-shielding materials 40
stringent security 93
supported discs 103
system board

removal 73
spare part numbers 21, 73

System Configuration
menu 89, 94

system failure or instability 102
system fan 94
system information 88, 92
system recovery 107
system resources 101
system restore points 102, 106

T
thermal paste,

replacement 81, 82
tools required 36

top cover
removal 55
spare part number 21, 55

TouchPad
buttons 9
identifying 9
removal 60

TouchPad button board
spare part number 60

TouchPad zone
identifying 9

transporting guidelines 39

U
Universal Serial Bus (USB) port,

pin assignments 113
USB board

removal 64
spare part number 24, 64

USB legacy support 90, 94
USB ports, identifying 14, 15
using Setup Utility 85
using system restore 106

V
vents, identifying 15, 16
Virtualization Technology 89

W
webcam

identifying 13
webcam light, identifying 13
Webcam module

spare part number 27
Windows applications key,

identifying 12
Windows logo key, identifying 12
wireless antenna

removal 70
wireless antennas 17
wireless antennas and cables

removal 71
spare part number 71

wireless antennas and cables,
spare part number 71

wireless light 10
wireless, product description 5
wireless/memory module

compartment cover
removal 50
spare part number 50

WLAN module
removal 49
spare part numbers 22, 49

workstation guidelines 39
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